





For information on a command, click the name of the menu in which it appears:

File Edit View Insert Modify Xtras Control Window

Or browse the alphabetical list of menu commands

For information on a window, click its name:

Cast Markers Text Inspector
Color Palettes Memory Inspector Text

Control Panel Message Toolbar
Debugger Paint Tool Palette
Field Score Video

Script Watcher
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Menu commands

Select a command or submenu listed alphabetically below:

Align

Arrange

Auto Distort

Auto Filter

Borders

Bring to Front

Cast

Cast Member

Cast Member Properties

Cast Member Script
Cast Preferences

Cast Properties

Cast to Time

Clear

Close Window

Color Palettes
Control Panel
Control: Push Button,

Radio Button, or Check Box

Control: Field

Convert to Bitmap
Copy

Create Film Loop
Create Projector

Cut

Debugger
Disable Scripts
Display

Duplicate

Edit Cast Member

Exchange Cast Members

Exit

Export

Field

Film Loop

Filter Bitmap

Find Again

Find Cast Member
Find Handler

Find Selection
Find Text

Font

Frame Palette
Frame Script
Frame Sound
Frame Tempo
Frame Transition
Frame

General Preferences

New Bitmap
New Cast

New Check Box
New Color Palette
New Field

New Movie

New OLE Object
New Radio Button
New Push Button
New Text

New Window

Open

Page Setup
Paint Preferences

Paint

Panel

Paragraph

Paste Special
Paste

Play

Preferences: Cast
Preferences: General
Preferences: Paint
Preferences: Score
Print

Recompile All Scripts
Remove All Breakpoints

Remove Frame

Repeat
Replace Again

Reverse Sequence
Revert

Rewind
Ruler

Run Script
Save All

Save and Compact
Save As

Save

Score Preferences

Select All

Selected Frames Only
Send to Back

Show Grid

Snap To Grid




Grid: Settings
Grid: Show

Grid: Snap To

Ignore Breakpoints

Import
In-Between

In-Between Special
Insert Frame command
Invert Selection

Loop Playback

Marker next

Marker previous
Markers Window

Media Element: Bitmap

Media Element: Color Palette

Media Element: Text

Memory Inspector

Message
Move Backward

Move Forward
Movie Casts

Movie Properties

So

Space to Time
Sprite Properties
Sprite Script
Stage

Step Backward
Step Forward

Step Into Script

Step Script
Stop
Transform Bitmap

Text Inspector
Text

Toggle Breakpoint
Toolbar

Tool Palette
Transform Bitmap
Tweak

Undo

Update Movies
Video

=




Using Director Help

This help system contains screens of information on using Macromedia Director. These
screens are arranged in topics.

You can navigate through help topics by clicking underlined words (in green):

. Click words with a solid underline to jump to a related topic. (For example, to go to
the contents screen click Contents).
. Click and hold words with a dotted underline to see pop-up graphics or text. For

example: pop-up).

Buttons at the top of the help window help you find help topics:
» Click the Contents button of the help screen to see a list of help categories.
L] Click the Search button to see an index to the Director help topics. The list on the
left shows each index entry in the Help system. When you select an index entry, the list on
the right shows each topic where the selected keyword is referenced. Double-click a topic to
display its help screen.

. Click the Back button to see the previously displayed help topic. (This feature is not
always available.)

. In Windows 3.1, click the History button to see a list of topics you have viewed. In
Windows 95, use the Display History Window command in the Options menu.

- In Windows 95, click the Print button to print the topic you are viewing. In Windows
3.1, use the Print Topic command in the File menu.

L Click the << and >> buttons to browse backward and forward through related

Director help topics. (These features are not always available.)

Acknowledgments and Copyright
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Select a category:

Animation
Bitmaps

Color palettes
Digital video

Text
Transitions
Xtras
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Select a category:

Animation Score
Bitmaps Shapes
Cast Sound
Color palettes Stage
Digital video Techniques
Lingo Tempo
OLE Text
Projectors Transitions

Xtras
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Cast

For an overview of working with casts, see:

Cast Window
Understanding internal and external casts

For information on creating cast members, see:

Creating a new cast member
Creating text cast members
Media Element: Bitmap
Media Element: Color Palette
Media Element: Text

For information on working with cast members, see:

Draqging cast members to the score

Moving cast members between casts

Moving cast members within the cast window
Placing cast members on the stage

Placing cast members over time

Using registration points

For information on cast member properties, see:

Cast member properties submenu (modify
menu)
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Score

For information about working in the score, see:

Selecting cells

Moving selections within the score
Moving around the score

Applying color to cells

About score window inks

Turning a channel on and off (score window)
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Stage
For information about working with the stage, see:
Stage
Resizing sprites on the stage
Placing cast members on the stage
For information on changing the size and location of the stage, see:
Movie properties command (modify menu)
For information on aligning sprites on the stage, see:
Aligh command (modify menu)

Show Grid (View menu)
Snap to Grid (View menu)

Grid Settings (View menu)




[ New | Besics [[Reterence | Lingo | shortcuts | ba@s
Animation

For information on basic animation, see:

Moving selections within the score
In-Between command (Modify menu)
In-Between Special command (Modify menu)
Arrange submenu (Modify menu)

Draqging cast members to the score

Placing cast members on the stage

Placing cast members over time

Cast to Time command (Modify menu)

Recording with Cast to Time

Space to Time command (Modify menu)

Step recording

Recording with Space to Time
Real-time recording in a channel

Understanding onion skinning
Update Movies command (Xtras menu)

Converting Director 4 movies
Protecting and compacting with Update movies
Understanding font mapping
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Bitmaps
For information on working with bitmaps in Director, see:

Paint window

Understanding color palettes

The paint window tools

Filter submenu (Xtras menu)

Auto Filter command (Xtras menu)
Auto Distort command (Xtras menu)
Understanding shapes and bitmaps

Creating a new cast member
Applying a filter to a bitmapped cast member
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Text

For information on working with text in Director, see:

Text window

Understanding text and fields
Paragraph command (Modify menu)
Font command (Modify menu)
Creating text cast members

Editing text on stage

Importing text
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Shapes

For information on working with shapes, see:

Creating shapes

Tool palette

Understanding shapes and bitmaps
Drawing with the shape tools
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Digital video movies

For information on digital video movies, see:

Importing digital video movies
Digital video window

Using multiple digital video windows
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Tempo
For information about setting and changing the tempo of your movies, see:

Frame Tempo command (Modify menu)
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Sound

For information on using sound, see:

Importing sound files

Frame Sound command (Modify menu)

Cast Member Properties: Sound (Modify menu)
Controlling sound (Lingo)
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Transitions

For information on using transitions, see:

Cast Member Properties: Transition (Modify menu)
Frame Transition command (Modify menu)
Installing Xtras
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Color palettes
For information on color palettes, see:
Understanding color palettes
Understanding color depth

Color palette window
Cast Member Properties: Palette (Modify menu)
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Projectors

For information on projectors, see:

Create Projector command (File menu)

Creating Projectors
Preparing a movie for distribution
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Lingo
For information on specific Lingo elements, see the main Lingo topic.

For information on using Lingo in scripts, see:

Writing scripts
Types of scripts

Using variables

Event message hierarchy
Working with casts
Puppeting

Sprite properties

Handling text
Controlling sound

Managing memory
Using movie in a window
Child-parent scripts
Using XCMDs
Generating score
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Xtras

For information on using and installing Xtras, see:

Using Xtras

Update Movies command (Xtras menu)
Frame Transition command (Modify menu)
Installing Xtras

Filter submenu (Xtras menu)

Auto Filter command (Xtras menu)

Using Auto Filter

Auto Distort command (Xtras menu)

Applying a filter to a bitmapped cast member
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OLE

For information on using OLE objects in Director, see:

Using OLE objects in Director
OLE Object command (Insert menu)
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Techniques

For information on techniques for using Director, see:

Converting Director animations into QuickTime movies

Importing Director movies
Memory management techniques
Using registration points
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Understanding shapes and bitmaps

Shapes are created in Director using the tool palette. They are 1-bit vector-based
graphics that are limited to basic lines, shapes, and patterns. Only text, not lines and
shapes, can be converted to bitmaps using the Convert to Bitmap command. Shapes are
always editable.

Bitmaps are either imported or are created in the Paint window. You cannot edit bitmaps
once you create them, but you can manipulate them using any paint functions. You can
create special effects by applying Photoshop filters.

Shapes animate more slowly than bitmaps, but bitmaps use more RAM and disk space.
Shapes are most often used as static, invisible buttons or placeholders on the stage.

P> See...

Shape
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Creating shapes

Create shapes with the line, rectangle, rounded rectangle, and circle tools. As with the
paint tools, clicking the right side of the tool produces a hollow shape. Clicking the left
side of the tool produces a shape filled with the current color or pattern in the pattern
chip.

-
v Tip
Pressing the Shift key while dragging constrains the tool to drawing a perfect square or

circle. The line tool is constrained to horizontal, vertical, or
45-degree lines with the Shift key.
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Resizing sprites on the stage

If you click a sprite on the stage, a border is displayed around it with a resize handle at
the border's right edge. Drag the resize handle to change the sprite's size on the stage.
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Selecting cells

Drag across cells to select them. If you have Playback Head Follows Selection checked in
the Score Preferences dialog box, the movie will advance or rewind as you select in
the score. You can see the frames on the stage as you select them in the score.

Action Shortcut
To select multiple adjacent cells Drag across cells or Shift-click
To select all the cells in a channel Double-click the channel humber and drag down

to select all the cells in adjacent channels.

To select all cells in multiple frames Drag across the frame numbers at the top of the

score.
To select all the cells in a frame Click a frame number at the top of the score.
To select all adjacent cells that Double-click an occupied cell
contain the same cast member
For discontinuous selections Control+click

" | S'ee"“Movin selections within the score
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Moving selections within the score

You can move the contents of one or more selected cells to a new location within the
score.

To move selected cells to a new location within the score:
1. Select the cells. The cursor changes to a hand.

2. To select additional frames, Shift-click them.

3. Drag the frames to the new location and release the mouse.

As you drag, an outline of your selection appears under the cursor. Dragging to the

edge of window will auto-scroll the window. To move a copy of the selection, press the
Alt key while dragging the selection.

The contents of the frames you move replace the contents of existing frames at the new
location.

If Playback Head Follows Selection is checked in the Score Preferences dialog box, the
selected frames will be displayed on the stage as you drag the selection in the score.
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Moving around the score

The playback head

The playback head at the top of the score indicates which frame of the movie is currently
on the stage. The playback head travels in the scratch bar as the movie plays. You can
drag the playback head or click to move to a specific frame. If Playback Head Follows
Selection is checked in the Score Preferences dialog box, the playback head travels
with any selection you make in the score.

The jump button

To move your view of the score to the current frame of your movie use the jump button,
located in the lower left corner of the score window. Whenever you click this button,
Director brings the playback head into view and your view of the score jumps to the
frame currently on the stage.

The jump to top button

If only the script channel is visible, clicking the jump to top button scrolls the score
window to the top of the effects channels.

The frame counter

The frame counter pops up in the middle of the horizontal scroll bar when you drag the
scroll box. It indicates how far you have advanced or rewound the movie as you drag the
scroll bar.

Move forward and move backward buttons

The move forward and move backward buttons let you move a selection of sprites up or
down in the score, to change their foreground priority on the stage. Move forward
switches a range of cells you've selected in a channel with the cells in the channel below
it. The sprites associated with the selected cells move in front of the other sprites. Move
backward switches a range of cells you've selected in a channel with the cells in the
channel above it. The sprites associated with the selected cells move behind the other
sprites.

Shortcut: Control+Shift+down arrow for move forward, Control+Shift+up arrow for
move backward.
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Applying color to cells

The cell color selector lets you apply color to score cells. The color only affects the cells
in the score; it does not affect how sprites appear on the stage.

To apply color to cells, select them and click a color from the cell color selector. The color
is carried with the cell if you move it or copy it.

You show or hide cell colors using the Enable Colored Cells option in the Score
Preferences dialog box. If you've already applied color to cells, hiding cell colors doesn't
remove their color. Score window performance is faster if you hide cell colors.
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Step-recording

Step-recording lets you create frame-by-frame animation in a channel. To activate step-
recording in a channel, Alt+click the channel number in the score where you want
recording to occur. Select additional channels by Alt+clicking their channel nhumbers.

Note: Step-record mode is automatically turned on if you drag cast members from the
cast window to the score or the stage.

A red step-recording indicator appears in the channels that are in step-record mode.

When you choose Step Forward from the Control menu or control panel, the sprite in
the channel with the step-recording indicator is copied into the next frame of your movie.

Step-recording remains in effect until you Alt+click the channel number again, click out
of the channel, drag the playback head, or click Rewind or Back Step.

To step-record animation:
1. Select the place in the score where you want Director to record the animation.
2. Drag a cast member from the cast window to the stage.

A sprite corresponding to the cast member appears on the stage. The thick selection
rectangle around the sprite indicates that Director is recording the sprite's position.

The step-record indicator appears next to the channel where Director is recording
information about the sprite.

To record a sprite that's already on the stage, click it to select it, and then Alt+click
the sprite to start recording. To stop recording, Alt+click it again.

3. Press 3 on the number pad, or click Step Forward control panel.

The movie advances to the next frame. The position of any sprite highlighted with a
thick selection rectangle is recorded in the new frame.

If a sprite you're recording is already present in the next cell of the channel where
you're recording its position, Director replaces the sprite's old position with its current
position.

Note: Recording stops when you move the playback head in any way other than
Step Forward.

4. Drag the sprite to reposition it.

You can also stretch the sprite or switch it with a sprite that corresponds to a different
cast member.

5. Repeat steps 3 and 4 until you've completed the sequence you want to record.
6. Rewind the movie or click a new frame in the score to stop recording.

Move the playback head to the beginning of the animation and run the movie to see
how it looks.
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Recording with Space to Time

Use the Space to Time command on the Modify menu to move the sprites from several
channels in one frame to consecutive cells in a single channel. When you create an
animated sequence made up of a series of cast members, you can arrange the sprites on
the stage in a single frame to see their positions in relation to one another. Once you've
finished arranging the sprites, use Space to Time to convert the frame into an animation.

To use the Space to Time command:
1. Select the place in the score where you want Director to record the animation.
2. Place cast members on the stage where you want them to appear in the animation.

As you position the sprites on the stage, Director places each one in a separate
channel in the score.

3. In the score, select all the sprites that are part of the sequence.
4. Choose Space to Time from the Modify menu.

The Space to Time dialog box appears. It lets you set the number of frames you want
between each sprite and the one following it.

5. Type the interval you want and then click OK.

Director rearranges the sprites so that instead of being arranged from top to bottom
in a single frame, they're arranged in sequence from left to right in a single channel.

If you've spaced the cells so that there are blank cells between them, you need to use
one of the In Between commands to fill in the blank cells.

-
v Tip
Space to Time is a fast way to set up the points you need for a curved In Between.
Arrange the cast members in one frame, choose Space to Time from the Modify menu,
and add 10 to 20 cells between each cast member to produce a smooth curve then
choose In-Between Special.
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Recording with Cast to Time

Use Cast to Time to move cast members to the score and arrange them in subsequent
frames in a single channel.

To add a sequence of cast members to the score:

1. Select the place in the score where you want to record the animation.
2. Make the cast window active.

3. Select the series of cast members to be added to the score.

4.

Choose Cast to Time from the Modify menu or hold down Alt and drag the cast
members to the stage.

The selected series of cast members is added to the score.

-
v Tip
Sometimes the series of cast members that's placed in the score jumps about the stage
when you play the movie. That's because the registration points of the cast members

aren't set properly. See Using registration points.
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Real-time recording in a channel (score window)

Real-time recording lets you record the movement of a sprite as you drag it across the
stage. The real-time recording technique is especially good for simulating the movement
of a cursor.

To activate real-time recording in a channel, press Control-Spacebar while clicking a cell
in the desired channel. To activate real-time recording in the first empty score channel,
just press Control-Spacebar.

An indicator appears next to the channel number to indicate that real-time recording will
occur in that channel. Only one channel at a time can be used for real-time recording.

To record in real time:

1.
2.

5.

T

Select the place in the score where you want Director to record the animation.
In the cast window, select the cast member you want to animate.

Make sure you select a cast member in the cast window rather than a sprite on the
stage. Also, don't drag the cast member from the cast window to the stage--just
select it.

To record a specific range of frames, select the frames, and then click the Selected
Frames Only button on the control panel.

Hold down the Control key and the spacebar.
The real-time record indicator appears next to the channel where you're recording.

Recording begins as soon as you click the mouse button in the next step, so be
prepared to move the mouse.

Point to the spot on the stage where you want the animation to start, press the
mouse button to begin recording, and drag the pointer across the stage.

Director records the path along which you move the pointer.

If there are sprites in any of the other channels in the first frame of the animation,
Director records their positions in each frame where it records the position of the
sprite you're moving.

Release the mouse button to stop recording.

ip

To have more control while recording in real time, use the tempo control in the

control panel to record at a speed that's slower than normal.

If you select Trails in the score, you can also use real-time recording to simulate

handwriting.
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Turning a channel on and off (score)

Turning a channel off tells Director to ignore the channel during playback. By default, all

channels are active. Clicking the button next to a channel turns the channel off, causing
Director to ignore that channel when you play the movie.

If you turn the script channel off, Director ignores all scripts during playback. (This is the
same as checking the Disable Scripts command in the Control menu.)

Channel on/off settings are not saved with the movie.
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Understanding internal and external casts

You can create multiple casts for your Director 5.0 movies. There are two types of casts,
internal and external. Prior to version 5.0 of Director, all casts were internal except
Shared.DIR and only one cast was allowed per movie.

Working with cast members within the cast window is the same regardless of whether
the cast is internal or external.

Internal casts

When you create a new movie, Director automatically creates an internal cast. Internal
casts are stored inside the movie file. When you save a movie, all internal casts are
saved. When you create a projector, they are stored inside the projector file. Internal
casts cannot be shared by other movies.

External casts

External casts are stored outside of the movie file. They can be shared between movies
or serve as libraries for commonly used movie elements. They are also useful for
distributing work in a project team.

When you create an external cast by choosing New Cast from the File menu, you have
the choice of linking or not linking the cast to the current movie.
L If you link an external cast to the current movie, Director opens the cast every time
you open the movie. If it can't find the cast in the original location, it prompts you to locate
the cast file. When you save a movie, all linked external casts are saved as well. The first
time you save a movie with a linked external cast file, Director prompts you to enter a file
name and choose a location for the file.
- If you don't link an external cast to a movie, you must open it separately with the
Open command on the File menu, and save it by activating the window and choosing Save
from the File menu. It is not saved along with the movie when you choose Save. If you move
a cast member to the stage or score from an unlinked external cast, Director prompts you to
link the cast to the current movie.

You can link and unlink existing casts to the current movie with the Movie Casts
command on the Modify menu.

L Cast window
Save command (File menu)

New Cast command (File menu)

Moving cast members between casts
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Moving cast members within the cast window

You can rearrange cast members within the cast window by dragging them to a new
location. When you select a cast member the pointer changes to a hand shape. Shift-
click to select additional adjacent cast members; Control-click to select additional non-
adjacent cast members.
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Moving cast members between casts

You can move cast members between casts by dragging them, just as you would move
them within a cast window.
. When you drag a cast member between internal and linked external casts, the cast
member is removed from the source location and placed in the destination.
. When you drag a cast member to or from an unlinked external cast, Director places a
copy in the destination and the original remains where it was.
» Alt-drag a cast member to copy it into a new cast window.

L Understanding internal and external casts
Moving cast members within the cast window
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Placing cast members on the stage

Placing cast members on the stage adds them to the score in the available channels of
the current frame. If you place more cast members than you have available channels of
the current frame, Director warns you that it will ignore the extra cast members.

When you place cast members on the stage (or in the score), Director adds them as
sprites. A sprite is an image of the cast member on the stage or in the score that
contains information about the cast member at one point in time.

Select a cast member in the cast window. Shift-click to select additional adjacent cast
members; Control-click to select additional non-adjacent cast members. Drag the
selection to the stage and release the mouse.

As you drag the cast members over the stage, Director displays an outline indicating the
size of the area enclosing all the cast members. (If you drag a sound or a palette, it does
not display an outline on the stage, as these cast members have no size dimensions.)

When you drop the cast members on the stage, step record is enabled in the channels
where the cast members were dropped.

Shortcut: Press Control+Shift+L to place selected cast members in the center of the
stage.
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Placing cast members over time

By default, when you drag cast members from the cast window, Director places multiple
cast members on the stage so that they all occupy the same frame in the score. To place
cast members on the stage over time instead of in the same frame, press Alt while
dragging the cast members from the cast window to the stage.

As you Alt+drag the cast members over the stage, Director displays an outline indicating
the dimensions of the first visual cast member in the selection, which will be placed in
the current frame. The rest of the cast members in the selection are placed into adjacent
frames.

If the score window is open while you are dragging cast members to the stage, Director
outlines the cells in the score where the cast member selection will be dropped. Director
restricts you to dropping cast members only into unoccupied cells in the score. (If you
instead drag the cast members directly from the cast window into the score, Director
does not prevent you from dropping the cast members into occupied cells and
overwriting existing sprites.)

When you drag a cast member to the stage, Director uses the first empty cell in the
current frame that is closest to the current score selection. (If you drag the cast member
directly into the score, you can more precisely specify the cell that will contain the cast
member.) You can force Director to use a certain set of empty cells by first selecting
them in the score before dragging in the cast members.

Shortcuts:
- Press Control+Alt+L to place selected cast members over time in the center of the
stage.
. You can also place selected cast members across time in the score by choosing Cast

to Time from the Modify menu.
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Dragging cast members to the score

Dragging cast members into the score places them into a range of cells and starts step-
record mode in the channels where the cast members are dropped.

To place one or more cast members into the score:
1. Click to select the first cast member in the cast window.

2. Shift-click to select additional adjacent cast members; Control+click to select
additional non-adjacent cast members.

3. Drag one of the cast members you just selected to the score. Dragging any selected
cast member drags the entire selection.

As you drag the cast members over the score, Director outlines the range of cells into
which the cast members will be dropped.

Director restricts you to specific regions of the score depending on the type of cast
members in the selection. For example, if you drag a sound cast member into the score,
Director restricts you to the two sound channels. If you are dragging different types of
cast members, Director lets you only drop them into cells of the appropriate type.

You can drag this Into this part
type of cast member of the score

Bitmap, PICT, Text, Field Sprite channels 1-48

Button, Shape, Film loop, Sound channel 1 or 2
Movie, Digital Video

Sound
Palette Palette channel
Script Script channel. (Not a movie script.)

When you drop cast members into the score, Director fills the highlighted cells in
sequential order by cast number. The first cast member in the selection of a particular
type will be dropped into the left-most or top-most cell in the channel.

Any occupied cells in the highlighted region are overwritten by the cast members you
drag in.
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Creating a new cast member

To create a new cast member, click the Add button. The keyboard shortcut for Add is
Control+Shift+A.

Director creates a new window in which you can create the cast member. Whatever you
create is placed in the first available cast member position.

The previous and next buttons control which cast member is displayed.
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Using rulers

The paint window has vertical and horizontal rulers to help you align and size your
artwork.

To use the rulers, choose Rulers from the View menu. The rulers appear at the top and
left side of the paint window.

The default unit of measurement is pixels. To change the unit of measurement, click the
corner where the rulers meet. With each click the unit of measurement changes.

To change the location of the zero point, drag right or left along the ruler at the top of the
window or up or down along the ruler at the side.
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Zooming in and out (paint window)

The Zoom commands on the View permit you to zoom in or out at four levels of
magnification.

To zoom in on the image in the paint window:
- Choose Zoom In (Control+plus sign) from the View menu to zoom in one degree of
magnification.
To zoom in on a particular feature of the image, Command-click the image, or
position the pointer over the feature before choosing Zoom In.
» Choose Zoom from the View menu and select a degree of magnification from the
submenu.

You can see a full-size view of the image in the box in the upper right corner of the paint
window. You can go back to the full-size view any time by clicking inside the box.

Zoom Out reverses the direction of the zoom. To reduce a magnified view, choose Zoom
Out (Control+minus) from the View menu.

Shortcut: Switch back and forth between normal size and the last level of
maghnification you chose by double-clicking the pencil tool or by Command-clicking with
any tool.



L ]
Selecting colors and patterns (paint window)

Colors and patterns are similar in the way you choose them and in the way you make use
of them. You choose both colors and patterns from pop-up palettes (the pop-up colors
palette isn't available if you have your monitor set to black and white), and you make
use of both with the same set of tools.

The colors that appear on the pop-up palette come from a set of colors known as a
palette. A Macintosh or Windows computer is capable of displaying over 16 million colors,
but it can only display a given set of colors at any one time, depending on the
capabilities of your video card. If the computer you're working with has a 4-bit video
card, you can work with palettes of 16 colors. If you're working with an 8-bit video card,
you'll be able to work with palettes of 256 colors.

Director has nine standard palettes: two System palettes (for Macintosh and Windows
systems), Rainbow, Grayscale, Pastels, Vivid, NTSC, Metallic, and VGA palettes. (The
standard palettes aren't all available all the time; which palettes are available depend on
the number of colors your monitor is set to display.) The System palette for your platform
is the default palette. You can create as many additional palettes as you want.

There are three types of colors you can choose from the current palette: The foreground
color is the color that you paint with when the pattern is solid and the ink is Normal. The
background color is the secondary color in a pattern. The destination color is the color
you want to replace the foreground color with when you use the Switch ink or the Switch
Colors button; when you use the Cycle ink, the destination color is the end of the range
of colors (beginning with the foreground color) that you want to cycle through; and when
you use the Gradient ink, the destination color and the foreground color define the two
extremes of the range that make up the color gradient.

Director has three standard palettes of patterns--Grays, Standard, and QuickDraw--as
well as a custom palette. The custom palette contains a set of default patterns; you can
create new patterns by editing the default patterns in the Pattern Settings dialog box.
You can also create a tile--a multicolored pattern that's a duplicate of a small rectangular
section of an existing cast member.



L]
Drawing with the shape tools

The shape tools are the line, rectangle, circle, and polygon tools. There are two tools
each for the rectangle, circle, and polygon tools: hollow version and a filled version.
When you use the hollow version, the shape you draw is only an outline; it is not filled
with a pattern or color. When you use the filled version, the shape you draw is filled with
the currently selected foreground and background colors and patterns.

If you press the Alt key while drawing with one of the shape tools, the border of the
shape is drawn with the current pattern.

If you press the Shift key while drawing with the line tool, the line is constrained to
horizontal, vertical, or 45-degree angles.

Double-clicking the shaded side of the rectangle, circle, or polygon tool opens the
Gradients.



L
Using registration points

When you create a cast member in the paint window, it is automatically assigned a
registration point in the center. You can see this by creating a simple cast member and
clicking the registration tool. When you click the tool, dotted lines appear in the paint
window. The intersection of these dotted lines is the registration point of the cast
member. Using registration points speeds your ability to quickly and accurately put cast
members on the stage and have them all line up with the same point.

The registration tool is used to line up cast members for frame-by-frame animation.
When you have a series of cast members, you can align their registration points so you
have a fixed reference point for animation. A simple example might be the hands of a
clock. The hands are made up of different cast members at various positions around the
face of the clock, but they must be anchored to the center of the clock. Setting a
registration point on the hands at the point about which they rotate enables them to line
up in the proper position on the stage.

Another example of using registration points is a running figure. You can set a
registration point at the same spot on the ground so when the series of running figures is
animated, they bounce up and down relative to the same point on the ground.

To set registration points:
1. Open the paint window to the first cast member in the series.
2. Select the registration tool.

3. Adjust the registration point or reset it to the default setting by dragging the
crosshair outside the window and releasing the mouse button.

4. Repeat this process until the registration points of all the cast members in the series
have been reset.



Creating tiles from a cast member

You can use tiles to make multi-colored patterns. There are eight default tiles that are
always available for you to use, or you can create your own. The tiles you create are
stored with the Director movie they were created in.

Once created, the tile appears in the patterns pop-up menu and can be used like any
other pattern. The current foreground and background colors have no effect on the color
of the tiles but switching palettes changes the color of the tiles.

To create a tile:

1.

Click the Pattern chip and choose Tile Settings from the bottom of the pop-up.

The radio buttons determine whether the tile you select is built-in or made from a
cast member.

Click Cast Member.

This radio button is dimmed if all the cast members in the movie are 1-bit cast
members. Tiles can be made only from cast members with color depths greater than
1 bit.

Click the left or right arrows to choose a cast member.

As you click the arrows, the cast members in the paint window appear in the left side
of the Tiles dialog box.

Choose a size using the Width and Height pop-up menus.

As you choose a width and height for your tile, the dotted box on the left side of the
Tiles dialog box changes shape to indicate the tile's size. You can also drag the dotted
box to make a tile from a different part of the cast member.

Click OK.
The tile you made is displayed in the bottom row of the pattern palette.

You can choose and use the tile just as you would select and use a pattern.



L]
Creating text cast members

There are two main ways to create text cast members:
. Create text cast members directly on stage using the text tool on the tool palette.
Click the text tool and then drag the pointer on stage to define the width of the text. When
you release the mouse button, a text insertion point appears in the area you just defined
and you can begin entering text. The new text cast member is placed in the first available
position in the cast. The sprite is assigned to the first open score cell in the current frame.
- Create text cast members in the text window by choosing Text from the New Media
submenu in the Insert menu or by clicking the text window tool on the toolbar. Text you
enter appears in the first available cast position, but it is not automatically placed on the
stage.

You can also create text cast members by importing text in the rich text format (RTF).
When importing text, Director creates a new cast member each time it encounters a hard
page break or a section break in the file. A cast member can include as much text as
memory allows.

L] Understanding text and fields
Importing text

Text Cast Member Properties




.
Understanding text and fields
There are three ways of working with text in Director. Each has distinct advantages for
different applications.
Rich text
Rich text is the type of text you create with the text tool or in the text window. It is

best suited for most applications and provides many features that were not possible in
earlier versions of Director.

L It offers paragraph formatting and definable tabs for each separate paragraph in a
cast member.
L] It is always editable in the authoring environment, but when you create a projector it

is bitmapped. Bitmapped text offers the best performance in animations and does not
require that users have the same fonts installed on their systems.

» Large fonts can be anti-aliased to improve on-screen appearance. No jagged lines
appear at corners or along angles. See anti-alias in the Text Cast Member Properties
dialog box.

L You can import from any application that stores text in the standard rich text format
(RTF). When importing text Director creates a new cast member each time it encounters a
hard page break in the file. See Importing text.

The text cannot be edited by users in playback or projectors, and it prints at 72 dpi.

Fields
A field is the type of text you create in any of the following ways:
» With the field tool on the tool palette
» By choosing Field from the Controls submenu of the Insert menu
» In the field window, which is opened by choosing the Field command from the

Window menu.

In general, you should only use fields if you need text that is editable in playback or
projectors, or you need the best available print quality. Prior to version 5.0, fields were
the only type of editable text available in Director. The disadvantages of fields are:

L] The formatting of text in fields is controlled by the system software, so users must
have the same fonts installed on their systems when they play the movie or projector.

. Paragraph formatting and tabs are not available.

. Fields can slow down animation.

Bitmapped text

Bitmapped text is text you create in the paint window, or import from other image
editing and paint programs. You cannot edit bitmapped text once you create it, but you
can manipulate it using any paint functions. You can, for example, create dramatic
effects by applying Photoshop filters to bitmapped text. The print quality of bitmapped
text is usually poor.

L Importing text
Creating text cast members



Text Cast Member Properties




L]
Editing text on stage

You can edit text directly on stage without opening the text window. Click a text sprite
once, and you can move the sprite on the stage just like any other sprite. Click twice to
make an insertion point appear within the text. Once the insertion point is visible, you
can enter or edit text just like you would in the text window. When you make a change,
Director updates all instances of the text cast member.

Change the width of a text or field cast member with the resize handle on the right
border.

Creating text cast members
Text Cast Member Properties




L]
Importing text

You can import text from any application that saves text as plain text or in the rich text
format (RTF). Choose Import from the File menu, choose Text from the Type pop-up
menu, and then double-click the file you want to import.

When importing rich text, Director creates a new cast member each time it encounters in
a hard page break or a section break in the file. A cast member can include as much text

as memory allows. Director assigns the name of the file you import to the cast member
name.

L Creating text cast members
Understanding text and fields

Text Cast Member Properties




L
Applying color to text

You can change the color of selected text using the pop-up color palette in the Font
dialog box. To change the background color of text, select the text cast member on stage
and then choose a color with the background color chip on the tool palette. This changes

the color of the entire cast member. You can't choose more than one background color
for a text cast member.



L]
Creating a digital video cast member

To add a digital video movie to the cast, you either paste it, import it, or choose Digital
Video from the New Media Element submenu in the Insert menu. Director automatically
links the movie to the cast and adds it to the cast window. If you paste the movie,
Director first asks you to name the file in which to store the movie.



L]
Using multiple digital video windows

You can create as many digital video windows as memory allows and play them
simultaneously. A movie continues playing even if it is not the front-most window.

You can also create multiple views of the same digital video window, to display the same
cast member in separate windows. This is useful for editing the movie, since you can
play the movie independently in each window, and cut and paste between each window.

Changes to the cast member in one window are automatically reflected in any other
windows that display the cast member.



About score window inks

Some score window inks work with both black and white and color artwork and others
work only with color. Inks that only work with color are: Bkgnd Transparent, Blend,
Darkest, Lightest, Add, Add Pin, Subtract, and Subtract Pin.

To apply an ink, select the cells in the score and then choose the ink from the ink pop-up
menu.

When dragging a cast member to the stage, the default ink is the last ink you chose in
the pop-up menu.

The default ink is Copy. When you use Copy, a bounding box appears around the sprite.
The bounding box is invisible when displayed on a white stage, but when the sprite
passes in front of another sprite, or the stage is black, you will see the bounding box.

To eliminate the bounding box that appears around a sprite, select the sprite in the score
and choose the Matte ink. Use it sparingly though, because it slows down screen redraw
and uses more memory than other inks.

To change the ink for a sprite, select the cell or cells, and choose an ink from the Ink pop-
up menu. Your choice replaces the previous ink assigned to the sprite.

Choose an ink carefully, since some inks can result in decreased performance when
animating a cast member. For example, the following inks are listed in order of
decreasing performance: Copy, Matte, Background Transparent, and Blend.

Note for Adobe Type Manager users: The following inks produce jagged text if you

have Adobe Type Manager installed: Not Transparent, Not Reverse, Not Ghost, Blend,
Darkest, Lightest, Add, Add Pin, Subtract, and Subtract Pin.

Ink pop-up menu



L]
Importing digital video movies

Importing a QuickTime or Video for Windows (AVI) movie automatically links the file to
the current movie and adds it to the cast window.

Any changes you make to the digital video movie with an editor outside Director are
reflected in the linked file.

Note: The imported digital video movie's contents do not become part of the Director
movie. If you make a copy of the Director movie, be sure to include all digital video
movies that are part of the movie.

» Video Window
Digital Video Cast Member Properties




L]
Installing Xtras

You can add three types of Xtras to Director: filters, transitions, and new cast member
types.

Xtras are available from third-party developers. You can install Photoshop filters in
Director as Xtras. You can also create your own Xtras if you can program in C.

To install an Xtra, copy the file to the Xtras folder inside the Director application folder. If
you use more than one Macromedia product, you should store Xtras in an Xtras folder in
the Macromedia folder in the Windows folder. You can create folders inside the Xtras
folder and Director will still find them.



L]
Importing sound files

Imported sounds are added to the cast window. You can import the following sound files:

. On the Mac, you can import System 7 sounds, AIFF files, and AIFC files. Compressed
System 7 sounds can only be played on Macintosh computers.
» In Windows, you can import WAVE, AIFF files, and AIFC files. Compressed WAVE

sounds can only be played on Windows computers.

Dialog box options
File displays sounds stored as files.
Resource displays sounds stored as resources in applications.
Linked lets you create a link to an AIFF or AIFC file on disk. Additionally, in Windows, you

can link to a WAVE sound file. You must create a link to a compressed sound file.

» Sound Cast Member Properties
Frame Properties: Sound




Understanding color palettes

For an entertaining, full-color demonstration of how color palettes affect your work in
Director, run the Color Palettes lab from the Director CD.

When your system is set to 8-bit color depth (256 colors) or less, it uses a limited set of
colors called a color palette. The color palette determines all the colors that can be

shown on the screen at the same time. This includes not only the colors for the images
you're working with, but system elements like title bars, dialog boxes, tools, and so on.

If your system is set to display 16-, 24-, or 32-bit color (thousands or millions of colors),
color palettes don't affect Director movies; they serve only as a means for selecting
colors in the paint window. Because they refer directly to a complete spectrum of colors,
16-, 24-, and 32-bit graphics do not require color palettes to achieve accurate color.

Color graphics with 2-, 4-, or 8-bit color depth don't store any information about the hue,
saturation, or brightness of any particular color. They identify colors by referring to
positions in the current color palette.

Where palettes come from

When working with 2-, 4-, or 8-bit graphics, many graphics programs create special
palettes with the best colors to display a particular image.

When you create 2-, 4-, or 8-bit graphics in any application, the active palette is linked to
the file. This palette must be active for the graphic to display the right colors.

Director includes several palettes. The system palettes are the default selections. Any
additional palettes you create or import appear as cast members.

Conflicting color palettes in Director movies

Only one palette can be active on your computer at a time. This causes problems in
Director when you try to put two bitmapped cast members on stage at the same time
that have different palettes; the colors for one of the images will be wrong.

While a movie is playing, the palette channel in the score determines the active palette.
When the playback head reaches a frame containing a new palette, it changes the active
palette. To make this change using Lingo, see the PuppetPalette command.

When a cast member you are placing on stage has a palette different from the currently
active palette, Director adds the new palette to the palette channel. The new palette
becomes the active palette, and it remains in effect until you set a different palette in the
palette channel. For more information about using the palette channel, see Frame
Palette command

Solving color palette problems

Here are some guidelines for solving problems caused by conflicting color palettes:
Make sure all cast members on stage at the same time refer to the same palette. This

is essential.



L Simplify your work and avoid frequent palette changes by mapping all the images in
your movie to as few palettes as possible.

L] If possible, create a palette that contains all the colors you need in your movie. You
can do this within Director by modifying an existing palette in the color palette window. You
can copy and paste colors from one palette to another. For information on using the color
palette window, see Color palettes window. Outside of Director, you can use a conversion
utility named DeBabelizer by Equilibrium software (Macintosh only) to scan groups of
images, create an optimal palette, and then remap all of them to the new palette. Some
image editing programs also have similar features

L] Remap existing cast members to a new color palette using the Transform Bitmap
command. See the next section, "Changing the palette of existing cast members."

L] As you import cast members, you can remap them to new palettes using the Image
Options.

L] If you don't understand what has been discussed so far, or if you're using images
with simple colors, you can avoid all of these complexities by using Transform Bitmap to
remap all of your images to the Windows or Macintosh system palette.

Changing the palette of existing cast members

You can remap existing bitmap cast members to different color palettes with Transform
Bitmap.

L Understanding color depth



L]
Understanding color depth

The number of colors a graphic image or a computer system can display is called the
color depth.

Color depth is expressed as the number of bits used to specify the color of each pixel, or
as the number of colors that can be displayed at once.

Bit Depth Number of colors
1-bit Black and white
2-bit 4

4-bit 16

8-bit 256

16-bit 32,768

32-bit 16.7 million

There are several reasons to use 8-bit graphics in your movies:

. Many low-end systems support only 8-bit graphics. If you intend to distribute to a
wide audience of low-end users, 8-bit is the safest choice.
. Graphics with lower color depth require less storage space, less memory to display,

and animate faster. Graphics with 16-bit color depth or more contain so much information
about color that they rapidly use up all available memory.

» Director for Windows 3.1 supports only 8-bit graphics. (Director for Windows 95
supports higher bit depths.)

To change the color depth of bitmap cast members:
1. Select the cast member you want to change.
2. Choose Transform Bitmap from the Modify menu.
3. Choose a new depth setting from the color depth pop-up and then click Transform.

To change the color depth of a movie:

1. Change your monitor's color depth setting in the control panel of your system
software.

2. Click Save in the File menu to save the movie or Save As to save the movie with a
new name.

. Understanding color palettes
Image Options




L]
Applying a filter to a bitmapped cast member

You can apply a filter to an entire bitmapped cast member, or to a selection in the paint
window.

To apply a filter:

1. Open the cast member in the paint window, or select the cast member in the cast
window.

You can apply a filter to several cast members at once by selecting them all in the
cast window. To apply a filter to a selected portion of a cast member, use the
selection rectangle or the lasso in the paint window to select the part you want to
change.

2. Choose Filter Bitmap from the Xtras menu.

3. In the Filter Bitmap dialog box, choose a category on the left and a filter on the right.
You can also choose All in the category list to view all the filters at once.

4. Click Filter.

Many filters require you to enter special settings. When you choose one of these
filters, a dialog box or some other type of control appears after you click Filter.

Some filters have no changeable settings. When you choose one of these, the cast
member changes with no further steps.



L]
Using OLE objects in Director

You can place OLE objects in Director movies as cast members. An OLE cast member is
treated as a bitmap inside of Director. For this reason, you should use OLE objects
primarily for images. Sound and video OLE objects are not effective.
» When you create an OLE object, it's created as an 8-bit cast member. Use the
Transform Bitmap command to change the bit depth. As you update from the server, the
OLE object changes in the cast to the new bit depth.
L Double-clicking an OLE cast member or sprite launches the OLE server so that you
can edit it. When you make changes in the OLE server and choose Update from the File
menu, the OLE object is automatically updated within Director.

L When you edit an OLE object, Director uses the standard cross-hatching to indicate
the object is in use by the server. When you quit the server, the cross-hatching disappears.
L] OLE objects are converted to bitmaps when you create a projector. They are no
longer linked to their source applications.

. OLE objects remain external files. Be sure to include all OLE files when you move a
movie or create a projector.

. OLE objects work only in Windows 95 and Windows NT.

' OLE Object command (Edit menu)




L
Using Auto Filter

Use Auto Filter to create dramatic animated effects with bitmap filters. Auto Filter applies
a filter incrementally to a series of cast members. You can use it either to change a range
of selected cast members, or to generate a series of new filtered cast members based on
a single cast member. You define a beginning and ending setting for the filter, and then
Auto Filter applies an intermediate filter value to each cast member.

To use Auto Filter:

1.

Select a bitmapped cast member, or a range of cast members, and then choose Auto
Filter from the Xtras menu.

To change only a portion of a bitmapped cast member, use the selection marquee or
the lasso in the paint window to select the part you want to change.

In the Auto Filter dialog box, select a filter.

Click Set Starting Values and use the filter controls to enter filter settings for the first
cast member in the sequence.

When you finish working with the filter controls, the Auto Filter dialog reappears.

Click Set Ending Values and use the filter controls to enter filter settings for the last
cast member in the sequence.

Enter the number of new cast members you want to create (the box is not available if
you have selected a range of cast members).

Click Filter to begin the filtering.

A message appears to show the progress. Some filters are very complex and require
extra time for computing.



L]
Understanding onion skinning

Related topics:

Tracing a cast member

Creating new cast members using a series of previous cast members as
reference images

Drawing a series of images by using another series of images as reference

images
Onion skinning and registration points

Onion skinning derives its name from a technique used by conventional animators who

draw on very thin "onion skin" paper so that they can see one or more of the previous
images in the animation.

Onion skinning in Director allows you to create or edit animated sequences of cast
members in the paint window using other cast members as a reference. Reference
images appear dimmed in the background. While working in the paint window you can
view not only the current cast member that you're painting, but one or more cast

members blended into the image. For a description of the onion skin toolbar, see Onion
Skin (View menu).

You can use onion skinning:
L] To trace over a image, or to create a series of images all registered with a particular
image.
. When drawing each cast member of an animation, to see previous images in the
seguence and use those images as a reference while you are drawing new ones.
. To create a series of images based on another "parallel" animation. A series of
images serves as the background while you paint a series of foreground images.



Tracing a cast member

Follow these steps to trace a new cast member using another cast member as a
background image:

1.
2.

o u kW

Open the paint window and select Onion Skin from the View menu.

Open the cast member in the paint window that you want to use as the reference
image or background.

Click Toggle Onion Skin (the left-most button in the toolbar) to turn onion skinning on.
Click Set Background in the toolbar to set the background image.

Click the Add button ("+") in the paint window to create a new cast member.

Click Show Background in the onion skin toolbar.

The original cast member now appears as a dimmed image in the paint window. All
painting operations now take place "on top of" the original cast member's image.

Paint the new cast member using the background image as a reference.



L]
Creating new cast members using a series of previous cast members
as reference images

You can create new cast members using other cast members as reference images. Use
the Preceding and the Following Cast Members buttons in the onion skin toolbar to help
you step through a series of cast members created for your animation.

#You can set Following Cast Members to display reference images following the current cast
member. Use the Preceding and Following Cast Members settings to help you step through a
series of cast members created for your animation.

In the following illustration, the Preceding Cast Members field is set to 2 so that images of
two previous cast members appear in the background as a new cast member is painted in
the foreground.



Drawing a series of images by using another series of images as
reference images

Follow these steps to use a series of images that serve as the background while painting
a series of foreground images.

1.

Arrange the series of cast members you want to use as your background, in
consecutive order in the cast.

Cast members in each of the foreground and the background series must be adjacent
to each in the other in the cast, otherwise Director cannot track the background
properly as you add cast members to the foreground.

Open the paint window and select Onion Skin from the View menu.

The onion skin toolbar appears.

Click Toggle Onion Skin in the onion skin toolbar to turn onion skinning on.
Make sure all values in the onion skin toolbar are set to 0.

Open the cast member in the paint window that you want to use as the first
background cast member in the reference series and click Set Background.

Select the position in the cast that you want the first cast member in the foreground
series to appear and click the Add button ("+") in the paint window to create a new
cast member.

The first cast member in the foreground series can be located anywhere in the cast.
Click Track Background in the onion skin toolbar.

The corresponding member of the reference series appears as a reference image.
Paint the new cast member using the background image as a reference.

When you have finished drawing the cast member, click the Add button ("+") again
to create the next cast member.

When Track Background is enabled, Director advances to the next cast member in
the reference series and its image appears in the background in the paint window.

Repeat step 8 until you have completed drawing the cast members in the series.



L]
Onion skinning and registration points

The current cast member and the reference images must be correctly registered with
each other. All images must be drawn with their registration points aligned.

By default, the registration point of a bitmap cast member is always the center of the
image. Director freezes the registration point of a bitmap cast member once it has been
used as a foreground or background image during onion skinning. For more information
about using registration points see, Using registration points.



L]
Linking to a file

When you import a PICT file, AIFF sound file, or a Director movie, you have the option to
create a link to the file in the cast rather than copying the contents of the file into your
movie. This allows you to add a PICT, sound, or Director movie to the current movie
without increasing the size of the movie. It also allows you share the same linked file
among several movies.

If you change the linked file, the changes are automatically reflected when you reopen
your movie. Director looks for any linked cast members when you open the movie. If it
cannot find a linked file, a dialog box appears so you can locate the file.

Note: Director always imports digital video movies by linking to the file.



L]
Importing PICT files

If you import a PICT file, Director converts it to a bitmapped cast member and adds it to
the cast.

The color depth of an imported PICT image depends upon the color depth of the monitor
on which Director's stage appears. For example, if the stage appears on a second
monitor when you import the image, the second monitor's color depth determines the
image's color depth.

Importing the cast member's palette ensures that the cast member looks as it did when
it was originally created.

Remapping the PICT file causes the cast member to appear in the colors closest to the
colors in the current palette.

Dialog box options

Linked creates a link to the location of the PICT file on disk. This is useful if you want to
add large (24-bit) images to your movie without increasing the movie's size.

Note: If you edit a linked PICT file, changes are reflected in the file on disk when you
save the movie. For example, if you import a 24-bit PICT file by linking to the file, and
later change its color depth using the Transform Bitmap command, Director alters the bit
depth of the PICT file on disk when you save the movie.
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Importing Director movies

Importing a movie adds the movie's contents (cast members, scripts, sounds, palettes,
text, artwork) to the cast window. Director converts the movie to a film loop in the cast,
imports all the movie's cast members, and updates their references to reflect their new
positions in the cast. The following items are not imported: movie script, resources,
tempos, transitions, and markers in the score. Score scripts are imported but are not
activated when you drag the film loop onto the stage.

Note: You cannot link to a movie created with a previous version of Director. To link the
movie, first update it to Director 5.0's file format using the Update Movies command in
the Xtras menu.

Dialog box options

Linked lets you create a link to the movie in the cast window. This option is useful if you

want to add a movie to your current movie without increasing the file size of your current
movie. The movie is imported as a film loop, without the individual cast members. If this

box is not checked, the movie itself will be imported into the cast.
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Converting Director animations into QuickTime movies

You can export a Director animation as a QuickTime movie, and then import it into
Director so that it becomes a single cast member. You might want to do this for the
following reasons:
» Since an imported digital video movie is linked to its source file on disk, you can edit
the digital video movie in another application, and your changes will be automatically
reflected in the digital video movie inside Director.

L Director provides precise control over the digital video movie's playback, using the
Digital Video Cast Member Properties dialog box.
L] Other users can use and distribute the QuickTime movie for use in any application

that supports QuickTime.

You might not want to convert a Director animation into a digital video movie if the
animation includes interactivity. (Digital video movies do not allow interactivity.)

Notes:
. If you lose your transitions when you export a Director movie as a digital video
movie, try increasing the Duration and Smoothness settings for the transitions before you
export the movie.
L] If the exported digital video movie plays before your transitions occur, turn off the
digital video movie cast member's Direct to Stage setting in the Cast Member Properties
dialog box.
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Memory management techniques

You use the same basic memory-management techniques on both Windows and

Macintosh:
L] Be conservative with memory-intensive cast members such as large internal sounds
and bitmaps. If possible, use external sounds instead of internal sounds.
* Keep animations as small as possible. If cast members are too big, you get a memory
error message when the movie is played back.
L] Create movies in several smaller segments instead of one large movie whenever

practical. Smaller segments are more likely to play back without pausing, and can begin and
end at logical breaks in the movie.

L Use trails to leave sprite images on stage if the sprite doesn't move and uses no
transitions.
L] Determine the minimum free memory that the movie will be required to use, and

then work backward from that minimum to make sure that your movie fits into available
memory. For example, you should take into account all global variables and objects, and
determine how much memory they will require. After subtracting this amount from the
projector size set by the system, you will know the amount of memory that remains for both
sound and graphic cast members in any one frame.

. Determine the available memory before playing a movie by entering put the
memorySize in the message window. You can also use put the freeBlock to see what's
happening to memory while you play the movie. You can also use the tracelLoad command
to display cast member names and other information about cast members as they are
loaded into memory.

- Using Lingo, include a check of the freeBlock before the movie starts to determine if
the minimum memory necessary to run is available. If not, display an alert informing the
user how much more memory is necessary.

» To determine how much memory a frame of a movie uses, use the ramNeeded Lingo
function.

. Use Cast Member Properties to tell Director when to purge a cast member from
memory. Make sure large cast members have an appropriate purge priority.

. Load cast members into memory on a "when needed" basis (specified using the Cast
Properties command on the Modify menu).

» If memory on the target machine is a consideration, create separate versions of your

Director movie, and design each one to run on machines with 5 megabytes, 8 megabytes, or
16 megabytes of physical RAM. Create a separate movie that checks the available RAM and
then calls the appropriate movie version.

L During authoring, use the Lingo properties the traceLoad and the traceLogFile to
determine when cast members are used in your movie. Set the cast member's unload option
in Cast Member Properties to make sure cast members that are needed frequently don't get
purged from memory.

Predicting bitmap size in memory

Most cast members are the same size in memory as they are on disk. However, bitmaps
can change size when they are loaded into memory, depending on the color resolution of
the playback monitor.

A 1-bit color depth image remains a 1-bit color depth image, but 4-bit and 8-bit images
adjust their color depth depending on which computer they play on. This has two
implications:
» A 4-bit cast member expands to twice its original file size in memory on a 256-color
monitor.



L An 8-bit cast member shrinks to half its original file size in memory on a 16-color
monitor.

The following formula measures how much memory a bitmap uses:

Number of bytes used by a bitmap=(image's height in pixels x image's width in pixels x
color depth in bits)/8

For example, a bitmap image that is 100x100 pixels and has a 4-bit color depth uses
5,000 bytes of memory: (100x100x4)/8=5,000.



Creating projectors

To create projectors for any version of Windows, you must use the Windows version of
Director; likewise you can only create Macintosh projectors with the Macintosh version of
Director.

Note: You can only include Director 5 movies in projectors. Use Update Movies to
convert older movies to the latest version of Director.

To create a projector:
1. Choose Create Projector from the File menu.

The Create Projector dialog box appears.
Double-click the movies and external casts you want to include in the projector.
Director transfers the name of the movie or cast to the file list.

If you want to add more movies to the projector, repeat the step for each one. If you
want to include all the movies that are in the folder that's open, click the Add All
button.

Use the Move Up and Move Down buttons to arrange the movies in the proper order.

Movies play in the order they appear in the list. Be sure to put the starting movie at
the top of the list. If your movie contains Lingo that switches between movies, the
order of the other movies may not be important.

To change any of the projector options, click Options.
The most important option is selecting the type of computer the projector will run on.

Windows Runs on
projector option

Windows NT and 95 Windows NT and 95
Windows 3.1 Windows 3.1--also runs slowly on Windows 95 and NT

Macintosh projector Runs on
option

Power Macintosh Native  Power Macintosh only

Standard Macintosh Macintosh older than Power Macintosh--also runs slowly on
Power Macintosh
All Macintosh All Macintosh systems at optimal speed, but the projector

file is much larger

Click Create.

A directory dialog box appears.

Name the projector, and then click OK.

Director turns the movies you've selected into a projector.

When you play a projector, it starts the play-only version of Director, plays the movie or
movies that are part of the projector, and then quits automatically.

Create Projector command



Preparing a movie for distribution




Preparing a movie for distribution

To distribute a movie to users who don't own Director, you need to create a projector.

A projector is a play-only version of a movie or series of movies. It appears as an
application program in your system software. When a projector runs, it automatically
begins playing the first movie and quits when the last movie finishes.

You cannot edit a projector in Director. You must edit the movie source file and then
Create a new projector.

When a projector plays, it accesses all external linked files the same way an ordinary
movie does. All linked media--bitmaps, sounds, digital videos, and so on--must be in the
same location relative to the projector as they were when the movie was created. To be
sure there is no problem when the you distribute the movie, place linked files in the
same folder as the projector, or in a folder inside the projector folder.

Organizing movies in a larger production

In most cases, you should divide a larger production into a series of smaller movies. You
can combine as many movies as you want in a projector, but larger files take longer to
save and are cumbersome to work with. Also, movies are easier to change if they are
organized in discrete sections.

The best way to organize a larger production is to create a small projector file that
launches the movie and then branches to other movies. This saves you the trouble of
creating a new projector every time you change one part of a movie.

Create Projector command
Creating Projectors
Update Movies



Protecting and compacting with Update Movies

During a project, use Update Movies to compact groups of files you have been working
on that may have become fragmented. (This is the same as using Save and Compact on
a file.)

At the end of a project, use it to compact and protect all your movies and casts at once.

A protected movie can be played only from a projector or as movie in a window. To play a
protected movie from a projector, you must use Lingo to go to or play the protected
movie. Protected casts can only be opened by protected movies.

To protect and compact movies and casts:

1.

Choose Update Movies from the Xtras menu.

The Update Movies dialog box appears.

Choose options for Action and Original Files.

Action defines whether the selected files are updated or protected. Original files
specified if original files are deleted or moved to a new folder you specify.

Click OK.

A dialog box appears with which you select files to change.

Select movies and casts you want to update and click Add.

Click Add All to add all the movies in the current folder. The movies you select appear

in the file list at the bottom of the dialog box. You can update movies in different
folders at the same time.

Choose Add All Includes Folders before you click the Add All button to make it include
any movies or casts inside folders appearing in the upper list. This option is useful for
updating large projects with several levels of folders.

Click Update.

Director saves new versions of the selected movies with the same names and
locations as the original movies. This ensures that all links and references to other
files continue to work properly. Director copies the original movies to the folder you
specified, recreating their original folder structure. If you didn't specify a folder for
the original movies, Director prompts you to select one.

Note: Director adds a .DXR suffix to protected movies, and .CXT to protected external
casts.

Update Movies command
Converting Director 4 movies




Converting Director 4 movies

You must use Update Movies to convert any Director 4 movie with a shared cast
(Shared.dir) to Director 5. To update movies from older versions (pre-4.0), you must first
convert them to the Director 4 file format.

Using Update Movies makes the following changes to movie files from Director 4:
Converts the movie into a Director 5.0 format file.
Converts a shared cast (Shared.dir) to a linked external cast named Shared.cst. It

renumbers the cast members so they begin with number one and updates all score
references to the new numbers. Make sure you select Shared.dir as one of the files to be
updated while using Update Movies.

Places transitions in the cast.

Lingo from pre-4.0 versions that was allowed in Director 4 may not work in Director 5. If
alert boxes inform you of script errors during Update Movies, this may be the problem.
Update Movies converts movies with old Lingo to the new file format, but they will
probably not run. To use theses movies in Director 5, you have to find and change the old
lingo. For information on outdated Lingo, see "Using outdated Lingo" in the introduction
to Learning Lingo.

Improved System-Win palette

Director 5 uses an improved System-Win palette. For compatibility, Director still includes
the System-Win palette provided in Director 4, which has been renamed "System-Win
(Dird)." You may notice that the Director user interface is a little brighter when it's the
active palette.

While your Director 4 movies will play with exactly the colors and artwork as in Director
4, it's easy to convert them to the new System-Win palette. To do so:

1. Make a copy of your movie.

2. Choose Movie Properties from the Modify menu and set the movie palette to System-
Win (Dir4).

3. Use Find Cast Member on the Edit menu to find all cast members in your movie that
use the System-Win (Dir4) palette.

Click Select All.

5. Choose Transform Bitmap from the Modify menu and remap those cast members to
System-Win.

6. Check the score for any references to the old palette.
7. Save your movie.

The colors in System-Win that were replaced are more subdued versions of the same
colors, so you should find the results to be generally pleasing.

Update Movies command
Protecting and compacting with Update movies
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Understanding font mapping

Director stores font, size, and style information for each text cast member. However,
when you open a movie created on a Macintosh using the Windows version of Director,
Windows may create visually different text than the text displayed on a Macintosh.

Most Windows PCs don't use the same fonts used in your Macintosh movie. If Windows
doesn't have one of these fonts, Director substitutes another available font.

Macintosh and Windows font sizes can differ. For example, 12-point text on the Macintosh
can appear smaller on the PC.

When you create a new movie, Director looks for a file called FONTMAP.TXT in the same
folder as the Director application. This file specifies how Director maps fonts between the
Macintosh and Windows platforms. If Director finds this file, it uses it to create an internal
font map for the movie. If no FONTMAP.TXT file exists, the new movie uses no font map.
When you open the movie on the PC, Director uses the movie's internal font map to
determine the appropriate substitute Windows fonts for text cast members that were
created on a Macintosh. If the movie has no font map, Director substitutes other
available fonts. The sample FONTMAP.TXT file at the end of this section provides an
example of how Director maps Macintosh fonts to Windows fonts.

If you want to guarantee that field text looks identical on both platforms, convert

your field cast members to bitmaps before opening the movie on the other platform. Be
aware, though, that bitmapped text uses more disk space and cannot be edited as text.

Use text cast members if you want identical looking text. Text cast members are not

dependent on playback-system fonts, they animate faster than fields, and they use only
slightly more memory (but they cannot be edited at playback time).

Buttons, which appear as field cast members, should not be converted to bitmaps.
Bitmapping buttons removes certain properties or attributes assigned to button cast
members and could affect Lingo scripts that refer to these button properties.

Editing a movie's FONTMAP.TXT file

Using fonts on high-resolution screens
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Editing a movie's FONTMAP.TXT file

When you open a new movie, Director looks for a font map file named FONTMAPR.TXT in
the same folder as the Director application. This file specifies the font mapping for all
new movies. If Director can't find this file, it does not use a font map for new movies.

You can edit an existing movie's font map file to specify which fonts Director substitutes
when you open the movie on the PC. Rather than creating this file from scratch, you can
save the movie's internal font map table in a text file, and then edit this file as necessary.

To define the font mapping information for a movie, it's more convenient to edit the
FONTMAP.TXT file before you begin authoring a movie, since Director automatically uses
the information stored in the FONTMAP.TXT file when you open a new movie. (If you've
already created the movie, you can still edit the font map file, but you will then have to
manually load the file into the movie to have Director apply it to the movie.)

Note: If you edit a text, field, or button cast member on the PC in a movie created on a
Macintosh, the cast member loses its original Macintosh font information. Similarly, if you
edit the text, field, or button cast member on the Macintosh for a movie created on the
PC, the cast member loses its original Windows font information. If you plan to edit a
movie on both the Macintosh and Windows platforms, make sure that the font mapping
file specifies that each Macintosh font has only one substitute font on the PC, and vice
versa. This one-to-one font mapping ensures that Director will be able to assign the
appropriate substitute font when you edit a text cast member on one platform and then
open the movie on the other platform.

A movie's FONTMAP.TXT file might look like this:

; This is a sample FONTMAP.TXT file

; Comments are denoted by using ";" or "--" to start the line

; The format for Font Mapping is:

; Platform:FontName => Platform:FontName [MAP (NONE | ALL)] [OLDSIZE =>
NEWSIZE]

-- The format for specific Character Mapping is

-- Platform: => Platform: OLDCHAR => NEWCHAR ...

; Here are sample mappings for the standard Mac fonts:

Mac:Chicago => Win:"MS Sans Serif"

Mac:Courier => Win:"Courier New"

Mac:Geneva => Win:System Map All
Mac:Helvetica => Win:Arial

Mac:Monaco => Win:Terminal

Mac:"New York" => Win:"MS Serif" Map None
Mac:Symbol => Win:Symbol

Mac:Times => Win:"Times New Roman" 14=>12 18=>14 24=>18 30=>24
; Here are sample mappings for the stock Windows fonts
Win:Arial => Mac:Helvetica Map All
Win:"Courier" => Mac:Courier

Win:"Courier New" => Mac:Courier

Win:"MS Serif" => Mac:"New York" Map None
Win:"MS Sans Serif" => Mac:Chicago

Win:Symbol => Mac:Symbol

Win:System => Mac:Geneva

Win:Terminal => Mac:Monaco

Win:"Times New Roman" => Mac:"Times" 12=>14 14=>18 18=>24 24=>30



Note: From Windows to Mac, Courier and Courier New map onto Courier. When coming
back to Windows only Courier New will be used.

Here is a sample character mapping for the bullet char

Mac: => Win: 165=>149
Win: => Win: 149=>165

Note:
. Comment lines must begin with two dashes (--) or a semicolon (;)
L] Only one font mapping definition can be specified on a line
» Arguments must be separated by spaces or tabs
L] If a font name consists of more than one word, it must be enclosed in quotation
marks

- Defining the font mapping for a new movie
Changing the font mapping for an existing movie
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Defining the font mapping for a new movie

To define the font mapping for a new movie:

1. Using any application that can edit text, open the sample FONTMAP.TXT file that's in
the same folder as the Director application.

When you installed Director, this file was placed in the same folder as the Director
application. If the file is missing, you can either re-install it or create it from scratch.
See the end of this section for an example of a FONTMAP.TXT file.

2. For each Macintosh font remapping entry, type on one line:

Mac:MacFontName=>Win:WinFontName [MAP (NONE|ALL)]
[MACfontsize=>WINfontsize]

where MacFontName is the name of the Macintosh font, and WinFontName is the
name of the Windows font being substituted for the Macintosh font.

The two arguments enclosed in brackets are optional. MAP ALL or MAP NONE
specifies whether you want to remap characters with ASCII values greater than 127
or just pass them through. The default is MAP ALL.

You can specify how you want the characters to be remapped, as described in Step 3.
The sample FONTMAP.TXT file contains mappings for a few commonly used graphical
characters.

The last argument, [MACfontsize=>WINfontsize], consists of one or more pairs of
numbers, separated by a space, that let you map a Macintosh font size to a Windows
font size.

Because font sizes appear smaller on a PC, you might want to map Macintosh font
sizes to larger Windows font sizes.

3. For each Macintosh special character that you want to remap, type:
Mac:=>Win: OLDCHAR=>NEWCHAR OLDCHAR=>NEWCHAR

where OLDCHAR is the ASCII value of the Macintosh special character, and NEWCHAR
is the ASCII value of the Windows character being substituted for it. You can enter as
many remapping pairs as you want by separating each one with a space.

You can only remap characters whose ASCII values are greater than 127 and less
than 255.

If you didn't specify MAP ALL for any of the font remapping entries, as described in
Step 2, you can skip this step.

Save the file as ASCII text, in the same folder as the Director application.
5. Open a new movie in Director.

When you open a new movie, Director looks for the font map file named
FONTMAP.TXT in the same folder as the Director application. All new movies will use
the font mapping information in the FONTMAP.TXT file. You can edit this file on a
movie-by-movie basis, as necessary.

Existing movies continue to use the font map information (if any) stored within the
movie rather than the font mapping specified in the FONTMAP.TXT file.



Changing the font mapping for an existing movie

To change the font mapping for an existing movie:

1.

w

© N oW

Using any text editing application, edit the FONTMAP.TXT file as described in "Editing
a movie's FONTMAP.TXT file," earlier in this section.

Save this file using any name of your choice.

Open the movie whose font mapping you want to change.

Choose Movie Properties on the Modify menu.

Click Load from File.

'fl_l'his option lets Director load the font mapping assignments specified in the font map
ile.

In the dialog box, select the font map file you just edited and click Open.

Click OK in the Movie Info dialog box.

Save the movie and close it.

Open the movie again.

The movie now uses the font map information specified in the font mapping file.
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Using fonts on high-resolution screens

Windows Setup program offers a Large font option, which uses a larger font on higher-
resolution screens. When using the Large font option, text in TrueType or System font on
an 800x600 pixel or larger display can wrap differently than it does on the Macintosh.

To avoid problems with the Large font option when playing back moves on screens larger
than 800x600 pixels, use Windows' Small font option whenever possible. When it is
necessary to use the Large font option, first test the movie on a large screen to verify
that text looks appropriate.
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Using XCMDs and XFCNs

Related topics:

Differences between Xobjects and XCMDs
Differences between XObjects and XCMDs
Learning to use XCMDs

Using an XCMD or XFCN

XCMDs and callbacks

XCMD and XFCN callback requests

Lingo lets you use HyperCard's XCMDs and XFCNs in your movies. Using XCMDGlue--part
of Director's *Standard.xlib library of XObjects-- you can access XCMDs and XFCNs from
Lingo scripts. This lets you can extend Director's capabilities by using the many XCMDs
and XFCNs available from HyperCard.

Most XCMDs and XFCNs work automatically with XCMDGIlue, but some may not.When the
XCMD's primary purpose is to perform a HyperCard-specific action--such as handling
cards, HyperTalk scripts, or other parts of the HyperCard interface--the XCMD or XFCN
might generate an error message when used in Director.

XCMDs and XFCNs are closely related. For convenience, Director Help refers to them
collectively as XCMDs.

Note: XCMDs provide an interface to external code modules but are not capable of
ensuring that the external code modules themselves perform as intended. You must
make sure that the external code modules perform correctly to have them produce the
desired results in Director.
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Differences between XObjects and XCMDs
XCMDGlue works differently from XObjects. You don't create instances of XCMDGlue to
work with specific XCMDs. Instead, XCMDGIlue acts as an interpreter between Lingo and
the XCMD.

A major difference between XCMDs and XObjects is that an XObject can have multiple

instances:
L One XObject can be used to create a number of independent objects, each capable of
performing different operations.
* An XCMD cannot create new instances, so it can perform only one function at a time.

For these cases, you can use Lingo to create a special mechanism which may solve the
problem. For further information, see the XCMDs and callbacks topic.
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Learning to use XCMDs
Related topics:

Opening XCMD resources
Viewing XCMD resources
Closing XCMD resources

Like using XObjects, using an XCMD involves three basic steps:
1. Opening the XCMD

2. Exchanging messages with the XCMD to perform some function

3. Closing the XCMD.

One of the best ways to learn about XCMDs is to use them in Director's message window.
In this section, you'll see how to open, view the contents of an XCMD resource by
exchanging a message with the XCMD, and close an XCMD.
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Opening XCMD resources

XCMDs can be located in two places: in an external file or in a Director movie.

When an XCMD resource is stored in the current movie's resource fork, the XCMD is
automatically opened when the movie is opened. This is similar to the way *Standard.xlib
is automatically opened when you launch Director. You can copy XCMD resources into
your Director movie using a resource editor like ResEdit.

When an XCMD resource is stored in an external file such as a resource file or stack, you
can open it with the openXlib command. If the file is in another folder, you must specify a
full pathname to the folder. The easiest way to access the file is to place it in the same
folder as your Director movie or the Director application.

To open an XCMD using the openXlib command:
1. Launch Director.

2. Open the message window and type openXlib followed by the name of the XCMD
resource file.

3. Press Return.
The resource file you specified opens.

One resource file can contain multiple XCMDs. When you use the openXlib command,
all XCMDs stored in the specified XCMD resource file are opened. The XCMD resource
file can be a HyperCard stack, a resource file, or even a TeachText document
containing XCMD resources. Notice that this is the same command used to open
regular XObjects.
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Viewing XCMD resources

After you've opened the XCMD, you can use the showXlib command to display all open
resource files that contain XCMDs as well as XObjects.

To display a list of all open resource files that contain XCMDs and Xobjects, ype showXlib
in the message window, and then press Return.

To display the contents of a specific XCMD resource file, type showXlib followed by the
name of the resource file, and then press Return.
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Closing XCMD resources

The closeXlib command lets you close all open resource files that contain XCMDs and
XObjects.

To close all open resource files that contain XCMDs and XObjects, type closeXlib in the
message window, and then press Return.

To close a specific resource file that contains XCMDs, type closeXlib followed by the name
of the resource file in the message window, and then press Return.
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Using an XCMD or XFCN

In many cases, once you open an XCMD, you can use the XCMD in your Lingo scripts the
same way you would use it in a HyperTalk script. XCMDGIlue does everything else by
converting the XCMD for you. For example, the following handler would let you use the
MIDIplay XCMD (from Opcode Systems) to play a MIDI file from Director:

on startMIDIplayback
openXlib (the pathname & "MIDIplay")
—-— opens the MIDIplay XCMD
—-— Use Lingo's "pathname" function to find
-- resource files
--— in the same folder as your movie
MIDIplay "open","MyDrive:MyFolder :myMIDIfile"
-- opens the MIDI file to be played
MIDIplay "start"
-- starts playback of the MIDI file

end startMIDIplayback

This handler stops the playback of the MIDI file:

on stopMIDIplayback

MIDIplay "stop"

closeX1lib (the pathname & "MIDIplay")
end stopMIDIplayback
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XCMDs and callbacks
Related topics:

Using a callback handler
Defining the callback factory
Creating the callback object
Specifying the callback handler

Not all XCMDs can be used with XCMDGlue in a completely transparent manner.
Occasionally, XCMDGlue is unable to properly convert the XCMD. When you attempt to
use an XCMD's syntax in a script, an error message is displayed.

Certain XCMDs may call on HyperCard to internally perform some tasks while the XCMD
is executing. Most of these are conversion routines and are used to conveniently convert
information to and from different formats. The remaining callbacks either involve the
HyperTalk interpreter or access information stored in HyperCard-specific entities such as
fields, or they do both. The table of HyperCard callback requests at the end of this
appendix lists specific technical information regarding these callbacks.

Lingo automatically supports all callbacks that are not overly specific to HyperCard. Still,
some HyperCard-specific callbacks are supported when Lingo provides a direct
equivalent. The remaining callbacks that are not automatically supported (a total of nine)
are so specific to HyperCard that they cannot be resolved automatically unless the
application calling the XCMD is virtually identical to HyperCard. Even in such cases, it is
still possible to use an XCMD by using a user-defined mechanism called a callback
handler.



Using a callback handler

A callback handler uses a Lingo factory to accept and respond to messages that
correspond to HyperCard callback requests. A factory is a set of scripts that can be used
to create an object. In Director 4.0, the functionality of factories has largely been
replaced by parent scripts. For more information on parent scripts, see Chapter 10,
"Parent Scripts and Child Objects." In this specific case, however, a factory provides the
best way to respond to callbacks. This section shows you the steps necessary to create a
callback factory, and to call that factory from a handler.

Essentially, a callback handler provides a mechanism that some XCMDs already expect to
be available. The XCMD expects that when it sends or receives a callback message,
something will be there to receive it and possibly return another message. (Usually
HyperCard does this.) A callback handler defined in Lingo simply intercepts and returns
these messages when appropriate. Whether you choose to use this information depends
on your understanding of the purpose of the callback.

Fortunately, when XCMDGlue does not understand a callback request, it indicates the
name of the callback in the error message. Once you know which callback your XCMD
needs to deal with, you can create a callback handler for it.

There are three basic steps to creating a callback handler:
1. Defining a callback factory
2. Creating the callback object

3. Specifying the XCMD to be used with the callback object (with the setCallBack
command that is part of XCMDGlue).
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Defining the callback factory

The first step in creating a callback factory is to define it. The following example factory

includes methods for all the callbacks that are not supported by XCMDGIlue. This factory

does not attempt to do anything with the callback requests other than create a record of
them in the message window. As you'll see later, you can use this information to process
callbacks. This factory should be placed in a movie script:

factory callBackFactory
method mNew
me (mPut, 1, "SendCardMessage")

me (mPut, 2, "EvalExpr")

me (mPut, 3, "StringLength")
me (mPut, 4, "StringMatch")

me (mPut, 5, "SendHCMessage")
me (mPut, 6, "ZeroBytes")

me (mPut, 7, "PasToZero")

me (mPut, 8, "ZeroToPas")

me (mPut, 9, "StrToLong")

me (mPut, 10, "StrToNum")

me (mPut, 11, "StrToBool")

me (mPut, 12, "StrToExt")

me (mPut, 13, "LongToStr")

me (mPut, 14, "NumToStr")

me (mPut, 15, "NumToHex")

me (mPut, 16, "BoolToStr")

me (mPut, 17, "ExtToStr")

me (mPut, 18, "GetGlobal")

me (mPut, 19, "SetGlobal")

me (mPut, 20, "GetFieldByName")
me (mPut, 21, "GetFieldByNum")
me (mPut, 22, "GetFieldByID")
me (mPut, 23, "SetFieldByName")
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me (mPut, 24, "SetFieldByNum")
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me (mPut, 25, "SetFieldByID")
me (mPut, 26, "StringEqual")

me (mPut, 27, "ReturnToPas")

me (mPut, 28, "ScanToReturn")
me (mPut, 31, "FormatScript")
me (mPut, 32, "ZeroTermHandle")
me (mPut, 33, "PrintTEHandle")
me (mPut, 34, "SendHCEvent")

me (mPut, 35, "HCWordBreakProc")
me (mPut, 36, "BeginXSound")

me (mPut, 37, "EndXSound")

me (mPut, 38, "RunHandler")

me (mPut, 39, "ScanToZero")

me (mPut, 40, "GetXResInfo'")

me (mPut, 41, "GetFilePath")

me (mPut, 42, "FrontDocWindow")
me (mPut, 43, "PointToStr")

me (mPut, 44, "RectToStr")

me (mPut, 45, "StrToPoint")

me (mPut, 46, "StrToRect")

me (mPut, 47, "GetFieldTE")

me (mPut, 48, "SetFieldTE")



me (mPut, 49, "GetObjectName")
me (mPut, 50, "GetObjectScript")
me (mPut, 51, "SetObjectScript")
me (mPut, 52, "StackNameToNum")
me (mPut, 53, "Notify")

me (mPut, 54, "ShowHCAlert")

me (mPut, 100, "NewXWindow/GetNewXWindow")
me (mPut, 101, "CloseXWindow")
me (mPut, 102, "SetXWIdleTime")
me (mPut, 103, "XWHasInterruptCode")
me (mPut, 104, "RegisterXWMenu")
me (mPut, 105, "BeginXWEdit/EndXWEdit")
me (mPut, 106, "SaveXWScript")
me (mPut, 107, "GetCheckPoints")
me (mPut, 108, "SetCheckPoints")
me (mPut, 109, "XWAllowReEntrancy")
me (mPut, 110, "SendWindowMessage")
me (mPut, 111, "HideHCPalettes")

me (mPut, 112, "ShowHCPalettes")

me (mPut, 113, "XWAlwaysMoveHigh")
me (mPut, 200, "GoScript")

me (mPut, 201, "StepScript")

me (mPut, 202, "AbortScript")

me (mPut, 203, "CountHandlers")

me (mPut, 204, "GetHandlerInfo")

me (mPut, 205, "GetVarInfo")

me (mPut, 206, "SetVarValue")

me (mPut, 207, "GetStackCrawl")

me (mPut, 208, "TraceScript")

method mEvalExpr x
put "mEvalExpr:" && x

method mSendHCMessage x
put "mSendHCMessage:" && X

method mSendCardMessage x
put "mSendCardMessage:" && x

method mGetFieldByName card, name
put "mGetFieldByName:" && card && name

method mGetFieldByNum card, num
put "mGetFieldByNum:" && card && num

method mGetFieldByID card, id
put "mGetFieldByID:" && card && id

method mSetFieldByName card, name, value
put "mSetFieldByName:" && card && name && value

method mSetFieldByNum card, num, value
put "mSetFieldByNum:" && card && num && value

method mSetFieldByID card, id, value
put "mSetFieldByID:" && card && id && value



method mUnknown which
put me (mGet, value(which)) into callBackName
put "mUnknown:" && which && " (" & —
callbackName & ")"

You do not need to specify every callback handled in this factory. You are required to
define methods only for the callbacks that are indicated in error dialogs generated by the
XCMD. For example, the mEvalExpr callback may be the only callback you need to
account for.

As indicated in this example, the put statements in each method are optional. They are
there to let you know what the XCMD or XFCN is attempting to tell HyperCard. You can
use this information in any way you want. Sometimes, a callback requires a value
(message) to be sent back to HyperCard. If you know what that value should be, use
return at the end of the specific callback method's script. For example, if a callback
required HyperCard to return TRUE or FALSE you could use a method similar to the
following:

method callBackMethod
if test then return TRUE else return FALSE
end callBackMethod
Some XCMDs use a large amount of processor time. In this situation, using a put
statement in your script slows down whatever the XCMD does, because the put
statement has to be evaluated and written into the message window. You can optimize
the callback factory in this case by removing the put statements.

When a callback error occurs, the XCMD usually stops running after you click OK in the
error dialog box. However, because of the design of certain XCMDs, the XCMD sometimes
continues to execute. You still need to create a callback handler for these XCMDs.
Otherwise, unexpected results could occur.



L]
Creating the callback object

After you have defined a callback factory, you can create a factory object using the
following statement:

put callbackFactory (mNew) into callbackObject



L
Specifying the callback handler

Finally, you specify the callback handler with the following statement:

setCallBack XCMD/XFCNname, callbackObject
The setCallBack command is part of the XCMDGlue XObject.

The XCMD or XFCN should now function properly. If you later use other elements of the
XCMD's syntax, you might still need to deal with other callbacks. You can accomplish this
easily by adding the appropriate method to your callback factory.



L
XCMD and XFCN callback requests

The following are HyperCard's callback requests. The symbol in the rightmost column
identifies which level of support is provided for each callback.

Number HyperCard callback Type*
1 SendCardMessage -
2 EvalExpr -
3 StringLength 4
4 StringMatch 4
5 SendHCMessage -
6 ZeroBytes 4
7 PasToZero 4
8 ZeroToPas 4
9 StrToLong 4
10 StrToNum 4
11 StrToBool 4
12 StrToExt 4
13 LongToStr 4
14 NumToStr 4
15 NumToHex 4
16 BoolToStr 4
17 ExtToStr 4
18 GetGlobal 4
19 SetGlobal 4
20 GetFieldByName -
21 GetFieldByNum -
22 GetFieldByID -
23 SetFieldByName -
24 SetFieldByNum -
25 SetFieldByID -
26 StringEqual 4
27 ReturnToPas 4
28 ScanToReturn 4
31 FormatScript -
32 ZeroTermHandle -
33 PrintTEHandle -
34 SendHCEvent -
35 HCWordBreakProc -
36 BeginXSound -
37 EndXSound -
38 RunHandler -
39 ScanToZero 4
40 GetXResInfo -
41 GetFilePath -
42 FrontDocWindow -
43 PointToStr -
44 RectToStr -
45 StrToPoint -
46 StrToRect -
47 GetFieldTE -
48 SetFieldTE -

49 GetObjectName -



50 GetObjectScript -

51 SetObjectScript -
52 StackNameToNum -
53 Notify -
54 ShowHCAlert -
100 NewXWindow/GetNewXWindow -
101 CloseXWindow -
102 SetXWIldleTime -
103 XWHaslInterruptCode -
104 RegisterXWMenu -
105 BeginXWEdit/EndXWEdit -
106 SaveXWScript -
107 GetCheckPoints -
108 SetCheckPoints -
109 XWAllowReEntrancy -
110 SendWindowMessage -
111 HideHCPalettes -
112 ShowHCPalettes -
113 XWAIlwaysMoveHigh -
200 GoScript -
201 StepScript -
202 AbortScript -
203 CountHandlers -
204 GetHandlerlnfo -
205 GetVarinfo -
206 SetVarValue -
207 GetStackCrawl -
208 TraceScript -

* 4. Automatically supported by Lingo

-: Requires a callback handler. Some messages and expressions (such as EvalExpr) may
be evaluated by XCMDGlue in a manner compatible with HyperTalk. Other messages
and expressions (such as GetFieldByName) always assume HyperCard entities for
which there are no counterpart in Director.
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FAQs -- multiple platforms

?

How do | take Director 5 movies from the Macintosh to Windows? Do | need to buy
Director 5 for Windows?

What about Director and Windows 95? Netscape? 0OS/27 Blackbird?



IR TN (T S e

FAQs -- general

.
My projector does not center on the stage, even though | have told it to do so in
Movie Info. Why?

.
When | import graphics into Director and apply Background Transparent ink effect to
them, the edges are not clean.

.
Why are my buttons being ignored when | have a Wait for Digital Video Movie to
Finish in Channel or other wait settings in the tempo channel?

L ]
How can | expand Director's printing capabilities?

.
Why do | get an out of memory error when importing a FLC or FLI on Windows, or a
PICS file on Macintosh?

.
How does Director work with a database?

.

How can | play a Director movie on a hard disk and keep its content on a CD-ROM?
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FAQs -- Macintosh

L
| have Director for Macintosh, and it is quitting with a Type 1 Error.

| am using Director for Macintosh, and all | want to do is make the area behind the
stage black.
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FAQs -- Microsoft Windows

.
When | use Director for Windows, | get a General Protection Fault.
.
Why do my 24-bit images look great in the cast window but look dithered when | put
them on the stage? | am using Director for Windows.
.
How do | play MPEG movies in Director for Windows?
]
How can | send MCI commands from Lingo? Where is a list of MClI commands?
.
When | run my Director for Windows projector, | get an error message that says
"Lingo.ini not found."
.
When | run my Director for Windows projector, it says "Handler not Defined: #FilelO."
.
In Director for Windows, when | play a QuickTime movie or an AVI file with sound, |
cannot play another sound file simultaneously. Why?
.
Is there a way to embed a custom icon for a Director for Windows projector?
.
Which installer do you recommend for Director for Windows projectors? Do you
recommend a compiler for DLLs?
.

How do | find the letter of a CD drive in Director for Windows?
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FAQs -- digital video

Where have the transitions and sounds gone when | export my Director movie to
digital video?

In Director for Windows, why does the controller of my QuickTime for Windows movie
stay on the stage when | jump to a new frame? Or, on the Macintosh, why does the
last frame of the digital video file stay on the screen when | jump to a new frame?

How can | make digital video files play as well as they do outside of Director?
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FAQs -- Lingo

L
How do | find the movie script?

.
How do | use a custom cursor in Director?

.
What is a mask cast member, and how do | make one?

.
| have a rollover test in a frame that works properly, but when | jump to a new
frame, that rollover area is still being evaluated even though the sprite is no longer
there. This also happens with the cursor of sprite property.

.

Where is a list of keyCodes?
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FAQs -- Made with Macromedia

Basic information regarding distribution of "Made with Macromedia" titles.
Who needs to comply with the Made with Macromedia logo requirements?

What if the Macromedia runtime is an insubstantial part of a commercially distributed
software product that was not Made with Macromedia?

I am using Shockwave™ to add multimedia to my web site. Am | required to use the
Made with Macromedia logo on my "Shocked" Web Site?

I qualify for either full or partial marking of the Made with Macromedia logo. What
are the steps | need to take to comply with this agreement?
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Technical support

If you think you need technical support, either online, by fax, or by phone:
1. Please read everything relevant to the problem in the manuals and the online help.

2. Check the index for more references to the topic. More information on a procedure or
feature may be found in a separate section.

3. If something used to work, think about what may have changed. Perhaps you
installed new software or changed some settings.

4. Try creating a new file and reproducing the problem there. If the problem goes away
in the new file, compare the new file with your old file to find and eliminate the
differences.

Note: Most of the problems you encounter can be solved by following the five steps
listed above.

If you still need help:

If you still need help at this point, a little advance preparation can save you time and
money, and allow the support representative to help you faster. Consult the following
checklist before contacting technical support:
* Please try to define the problem so that you can repeat the steps that led to the
problem and specifically identify when and how the problem occurred. The support
representative will need to know exactly what the problem is in order to provide help.
L Be able to provide the following information:

- Product name, version number, and product registration number

- Type of computer, such as 386, 486 or Pentium, local-bus or non-local bus,
Quadra or PowerMac

- Amount of memory installed
- Amount of free hard disk space
- Screen resolution (screen size in pixels, for example, 1024 by 768)

- Screen color depth (number of colors or bits, for example, 256 colors or 8-bit
color)

- Graphics card manufacturer, model name, and driver version number.
- Sound card manufacturer and model name

- DOS and Windows or Macintosh System version numbers

- Alist of external devices connected to the computer

- Brief description of the problem or error, and the specific text of any error
messages

These steps will help us pinpoint and solve your problem more quickly.

Technical support:
Inside the U.S. and Canada
Outside the U.S. and Canada
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Contacting Macromedia

Technical Support
Sales: Call 800-288-4797

Source & Center
Call 800-396-0129 or 415-252-7999.

Contact Source & Center for training, consulting services, purchasing Priority Access
technical support, referrals for multimedia development, referrals to Macromedia
Authorized Graphics/Imaging Centers (MAGIC) and to user groups, and authorization
programs for trainers, developers and service bureaus.

Macromedia International User Conference
Call 415-252-7999

Success Stories
pr@macromedia.com
fax 415-626-1502

Product Suggestions and Feedback
director@macromedia.com
fax 415-626-0554.

Contact the Director Product Team with product suggestions and feedback about
Director.

World Wide Web
http://www.macromedia.com/

Made with Macromedia program
Call 415-252-2000.
Macromedia offers Director 5 developers the ability to distribute applications created
in Director without paying royalties. Our new Macromedia licensing policy allows you

to distribute your Director projects royalty-free, provided you include the Made with
Macromedia logo as described in our guidelines.
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Technical support inside the United States and Canada

Debugging, designing, creating

Please note that technical support can answer installation, configuration, and general
usage questions about the product. For help in debugging, designing, or creating your
application, contact Macromedia Professional Consulting Services at 415-252-2245.

Online services

Information about Director is available in Macromedia's forums on CompuServe, America
Online, Microsoft Network, and also at various sites on the Internet. For an up-to-date list
of all of the resources available online, call MacroFacts, Macromedia's 24-hour fax
information line and request document 3503. In the United States and Canada, call 800-
449-3329. From elsewhere, call 415-863-44009.
» CompusServe: To reach the Macromedia forum on CompuServe, use the command
Go Macromedia. On CompuServe, we provide message areas for discussion of multimedia
development and support of our products, as well as libraries that contain useful utilities and
examples--including drivers, models, DLLs, and XCMDs.
. America Online: In the United States, to reach the Macromedia forum on America
Online, use the keyword Macromedia. On America Online, we provide message areas for
discussion of multimedia development and support of our products, as well as libraries that
contain useful utilities and examples--including drivers, models, DLLs, and XCMDs.
. Microsoft Network: To reach the Macromedia forum on Microsoft Network, use the
command Goto Macromedia. On Microsoft Network, we provide message areas for discussion
of multimedia development and support of our products, as well as libraries that contain
useful utilities and examples--including drivers, models, DLLs, and XCMDs.

MacroFacts
Macromedia's 24-hour fax information line, providing instant access to Macromedia's
products and services. In the United States and Canada, call 800-449-3329. From
elsewhere, call 415-863-44009.

Contacting Technical Support
Technical Support fax: 415-703-0924
Technical Support phone: 415-252-9080
Macromedia, Inc.

600 Townsend Street
San Francisco, CA 94103
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Technical support outside the United States and Canada
Online services

Information about Director is available in Macromedia's forums on CompuServe,
Microsoft Network, and also at various sites on the Internet. For an up-to-date list of all of
the resources available online, call MacroFacts, Macromedia's 24-hour fax information
line and request document 3503. You can reach MacroFacts by calling 415-863-4409.
» CompuServe: To reach the Macromedia forum on CompuServe, use the command
Go Macromedia. On CompuServe, we provide message areas for discussion of multimedia
development and support of our products, as well as libraries that contain useful utilities and
examples--including drivers, models, DLLs, and XCMDs.
L] Microsoft Network: To reach the Macromedia forum on Microsoft Network, use the
command Goto Macromedia. On Microsoft Network, we provide message areas for discussion
of multimedia development and support of our products, as well as libraries that contain
useful utilities and examples--including drivers, models, DLLs, and XCMDs.

MacroFacts

Macromedia's 24-hour fax information line, providing instant access to Macromedia's
products and services. You can reach MacroFacts by calling 415-863-4409.

If you're looking for assistance by fax or phone internationally, please contact the vendor
or the distributor from which you acquired Director.

For additional help, contact the Macromedia office in your area:

. Macromedia Europe (including Europe, the Middle East, and Africa)
4 Wellington Business Park

Dukes Ride, Crowthorne Berkshire

England

United Kingdom RG45 6LS

44.1344.76.1111
44.1344.76.1149 (fax)
44.1344.750.517 (fax)

» Macromedia Japan
Serom Building 3F
Shinsen-Cho 11-7
Shibuya-Ku

Tokyo

Japan 150

81.3.3462.5790
81.3.3462.5794 (fax)

> Macromedia Asia Pacific
9 Minto St

East Kew, Victoria

Australia 3102



61 3 9859 8325
61 3 9859 4162 (fax)

L For Pacific and Latin America
Macromedia

600 Townsend Street

San Francisco, CA 94103

U.S.A

415-252-2267
415-626-0554 (fax)
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How do | take Director 5 movies from the Macintosh to Windows? Do | need to
purchase Director 5 for Windows?

Yes, you need to have Director for Windows to make an Director executable (projector)
for the Windows platform. Director movies play on both platforms, but the projectors
themselves are platform-specific.

In general, you do not need to duplicate your work. Most of what you do in Director will
be exactly the same on both platforms. You can open the same movie on the Macintosh
and Windows machine. Even the Lingo is the same. Most of the other issues you will deal
with will include your content: making sure that your cast members work on both
platforms as well.

Our best advice would be to work with both platforms from the beginning of your project.
You should be successful if you test early, test often, and test on all target machines.
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What about Director and Windows 95? Netscape? 0S/2? Blackbird?
Director for Windows 5 runs on Windows 95, Windows NT, and Windows 3.1.

There have been announcements made of the development of Director playback
technologies for Netscape, 0S/2 Warp, Blackbird, and others.

The best resource on the latest information of Director and Macromedia developments is
the press release area of our CompuServe and America Online forums, and our web
page: http://www.macromedia.com.
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My projector will not center on the stage, even though | have told it to do so in
the Movie Info dialog box. Why?

If you would like to avoid all of this, you can also use a Lingo command in your on
startMovie handler to: "set the centerStage to TRUE".



IR TN (T S e

When | bring my graphics into Director and apply Background Transparent ink
effect to them, the edges are not clean.

Imported images may have very light shades around the edges that look white to the
eye, but are slightly darker than true white. Background Transparent ink effect subtracts
one color only. The default for this background color is white, the first indexed position of
a palette. You can change the background color of a sprite by selecting the sprite on the
stage and selecting a different color in background chip of the Tools window.

Some techniques used to work with these light colors are:

1. Use the eyedropper tool in the paint window to determine the position in the palette
the light color. Select the image in the paint window with the selection rectangle tool
in Shrink or No Shrink modes. Select the paintbrush and the switch ink effect to
change that color to a true white.

2. Often images that are anti-aliased against a white background get a halo around
them because the image has feathered edges with intermediate colors between the
object color and the white background. One good solution is to recreate the image
without anti-aliasing, or edit the edges by hand.
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Why are my buttons being ignored when | have a Wait for Digital Video Movie to
Finish in Channel X, or other wait settings in the tempo channel?

The tempo channel is intended for use in straightforward, linear presentations. It is quick
and easy, and perfect for slide shows. If you begin to use Lingo to add interactive control
of you movie, it is good practice to use Lingo alone.

Say, for example, you have written a sprite script for a button to "go to the frame +
1". If you also have a Wait for Digital Video Movie to Finish in Channel: X set in the tempo
channel, Director will not know which message to execute. The tempo channel and Lingo
compete for control of score navigation.

The good news is you can script everything in the tempo channel with Lingo and
maintain interactivity at the same time.
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How can | expand Director's printing capabilities?

From within the Director application, you can print for authoring purposes of previewing
the stage, your scripts, cast members and more. For many reasons, one being to keep
the size of the projector small, Director projectors have simple printing engines.

You can use the Lingo printFrom command to print the stage in a projector at 25, 50 or
100%. It is also possible to use third-party solutions to enhance the printing capabilities
of a projector. Please take a look on our CompuServe and America Online forums or our
web page for information and demonstration copies of those available. One of these
most commonly used at this time is the PrintOMatic Xtra.
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Why do | get an out of memory error when importing a FLC or FLI on Windows, or
a PICS file on Macintosh?

When you import a FLC/FLI or PICS file into Director, a 27-frame file for example, it is
similar to bringing in 27 full screen graphics at one time. If you have been working for a
while, you could run out of memory if you try to import all of these graphics at once. This
is a very common error when importing large 3D files.

What you will need to do is this:
1. Import one small section of the PICS (Mac) or FLC/FLI (Windows) file at a time.

2. Save the file by choosing Save and Compact (this will re-write the file and your
changes).

3. Go into About Director, and choose to purge the memory.
4. Repeat this sequence again, or a few more times, depending on the size of the file.

Once the entire animation is in Director, you can put it back together on the stage with
"Cast To Time." You may want to make sure in the paint window that the registration
points of all of the images are the same. Double-click the registration tool to make sure it
is in the center of each image.

To find more 3D animation discussions and techniques, take a look at the technical
support KnowledgeBase file, available on our CompuServe and America Online forums,
and web page.
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How does Director work with a database?

You have a couple of options when working with databases and Director. You can either
create your own database structure by using Lingo's lists. This is an easy and fast, cross-
platform solution.

If you would like to communicate with an external database, you can use one of many
Xtras available from third parties to do so. Some issues you may need to consider if
using this approach include: cross-platform compatibility issues for the database, how to
distribute the database, and the overhead of running multiple applications on the target
machine. Information on these third party utilities can be found on our CompuServe and
America Online forums and web page: http://www.macromedia.com.
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I have Director for Macintosh, and it is quitting with a Type 1 Error.

Type 1 Error is a bus error, one of the most common errors on the Macintosh. It could
mean a number of things, in order of severity. If you receive a Type 1 Error while running
Director, you should run through this list of steps:

1.

Allocate more memory to Director:

- Quit Director.

- Select the Director application icon in the Director folder (do not launch it).

- Select Get Info from the File Menu.

- Allocate more memory to the Preferred size for Director.

- Try the task you were doing before.

If that does not work, disable all of your extensions:

- Restart your computer and hold down the Shift key.

- Keep the Shift key down until a message comes up saying "Extensions Disabled."

If the error goes away, you should work through your extensions to see which one(s)
might be conflicting. We do not keep a list of extensions known to be incompatible
chiefly because of the difficulty in creating such a list. It would be more descriptive to
make a list of extensions that, under some circumstances, can lead to problems in
Director. Sometimes two extensions that cause no problems by themselves will cause
Macintosh applications to go haywire if they are both active at the same time.
Similarly, extension conflicts can be the result of load order.

Director does not require any extensions, except QuickTime if you are using
QuickTime movies. If you find that there is an extension conflict on your machine, you
can use an Extension Manager (one ships with System 7.5) to disable all of your
extensions except QuickTime while working in Director.

If that does not work, reinstall Director.
If that does not work, reinstall the System Software.
A full list of all the Macintosh System errors is available from Apple.
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I am using Director for Macintosh, and all | want to do is make the area behind the
stage black.
To do this in a projector, simply choose Full Screen in the Projector Options dialog box.
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When | use Director for Windows, | get a General Protection Fault.

If you get a General Protection Fault when starting up Director in module DIRSWIN.DLL,
then you might have the HP Deskjet printer driver set up as default in the Printers control
panel. Selecting a different printer driver or making "none" the default should fix the
problem.

If the General Protection Fault occurs in this module at another time during development,
or in a different module, it is most likely a display driver issue. Switching to the Microsoft
"VGA" display drivers will test if this is the problem.



IR TN (T S e

Why do my 24-bit images look great in the cast window but look dithered when I
put them on the stage? | am using Director for Windows 3.1.

Director for Windows 3.1 displays bitmap sprites on stage in 8-bit color depth (256
colors) or less. We do so to abide by a Microsoft standard set in Windows 3.1 to ensure
the highest level of compatibility with a broader range of video display drivers. Director 5
run on Windows 95 and NT supports 24-bit color.

This limitation does not apply to digital video, like QuickTime for Windows and Video for
Windows. Digital video goes through a different display buffer than the other sprites on
the Director stage. One option you have is to convert your bitmaps to one-frame digital
video files, as they are optimized to color depths greater than 8-bit. Because they play
directly to the screen buffer, however, you will not be able to overlay sprites on top of
them during playback.

The best technique, however, to maintain the score's 48 channel layering effects, would
be dither your graphics to a custom 8-bit palette.
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How do I play MPEG movies in Director for Windows?

Director uses the Lingo MClI command to pass strings to an MPEG playback controller
such as the ReelMagic card. Initially, when Director for Windows shipped, you could only
play the MPEG file and not control it. You can now get the "handle" to the MPEG window
by using DLLGLue XObject, available on our CompuServe and America Online forums,
and web page. Sample scripts come with the DLL Glue XObject, and a help file on MCI,
called "MCISTRWH.HLP," is available in our CompuServe and America Online forums, and

web page.
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How can | send MCI commands from Lingo? Where is a list of MCl commands?

Director can send MCI commands from Lingo with the mci "string" command. The
command you insert in the "string" area is documented with the device you are trying
to control. See the mci help topic for information on using the Lingo mci command.
Microsoft has a series of help files and technical documents on CompuServe and in their
multimedia developer's kit. An MCI help file, called MCISTRWH.HLP, is located in our
libraries on our CompuServe and America Online forums, as well as our web page:
http:///www.macromedia.com.
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When | run my Director for Windows projector, | get an error message that says
"Lingo.ini not found."

The two most frequent causes of this problem include:

1. A particular Cirrus Logic video driver that overwrites other areas of memory. Solution:

Get newer Cirrus Logic video drivers from Cirrus Logic or use the generic Microsoft
SVGA (640x480x256) driver.

2 A multimedia shell is in use on a low-end machine, thus, reducing system resources

and available RAM below a workable level. The solution is to run straight Program
Manager instead.
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When | run my Director for Windows projector, it says "Handler not Defined:
#FilelO."

Upon launching, the Director for Windows projector looks for a text file called "LINGO.INI".
This file can be useful for last minute instructions for your completed Director project.

The projector looks for it in its own directory and then scans the DOS path, and when it
finds a LINGO.INI file, it follows its instructions. The default LINGO.INI (in the Director
application directory) has many comments and one solitary command: "openxlib
'fileio'." Comment this out and put a copy of the file in the same directory as your
projector, and it will never ask for FILEIO.DLL again.

If by chance a LINGO.INI file from a different application created with Director remains on
that machine, the projector will follow the instructions it finds first. (There was a
LINGO.INI file associated with the Director Player for Windows projector as well.) You
might get other errors at that time. Your safest bet is to supply a text file in the same
directory as your projector, and call it "LINGO.INL." Even if it is blank, the projector will
read it first and continue without any errors.

If you are using the FilelO XObject with Director for Windows, you will need to supply the
FILEIO.DLL in the same directory as your projector. FilelO is not embedded into the
Director Windows application as it is on the Macintosh. For more information on what to
distribute with your Director for Windows projector, please refer to the "PROJECT.WRI" file
in the Director for Windows application directory.
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In Director for Windows, when | play a QuickTime movie or an AVI file with sound,
I cannot play another sound file simultaneously. Why?

The fact is that Windows supports only one sound channel. Director for Windows can play
more than one sound at a time (.\WAV or .AlIF) because it mixes them together.
Macromedia created a technology called MACROMIX.DLL that allows Director to do this.
In Director for Windows 4.0, it was necessary that the sounds needed to be of the same
sampling rate (11.025, 22.05, 44.1 kHz) and sample sizes (8-bit and 16-bit) in order to
mix them together. This is no longer true in Director for Windows 5.

What Director cannot do is mix sounds for QuickTime for Windows or AVl movies with
audio files. Whichever sound gets to the sound port first, wins. The second sound will not
be able to start playing until the first sound is completely finished with the sound
channel.

The Director for Windows "README.WRI" file recommends to keep at least one frame
between video and audio sources. Other techniques used to make sure the first sound is
completely finished include:

for a puppetSound: puppetSound 0
for a digital video:  set the movieRate of sprite X to 0



IR TN (T S e

Is there a way to embed a custom icon for a Director for Windows projector?

The best (least risky) way to do this in Windows is to change the icon inside the
PROJECTR.SKL file. It should be installed into the same directory as DIRECTOR.EXE.

1.
2.

o v AW

Make a backup copy of PROJECTOR.SKL.

Open PROJECTOR.SKL as an .EXE in your favorite resource editor (One recommended
is AppStudio).

Edit the icon. It's in the icon resource called APPICON.

Save the file. Make sure it is still called PROJECTOR.SKL and is in the same directory.
Create a projector with your own icon.

Optional: restore the original version of PROJECTOR.SKL.

AppStudio comes with Microsoft's Visual C++.

Note: Borland Resource Workshop versions 4.0 and 4.0.2 will NOT work for this
procedure. (It comes with Borland C++.) The Director projector skeleton includes half a
megabyte of code, but BRW will not recognize those code elements -- it only understands
resources. Thus, you will run into "unexpected file format" errors trying to save your
updated PROJECTR.SKL file as an EXE.
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Which installer do you recommend for Director for Windows projectors? Do you
recommend a compiler for DLLs?

There are many installer and compiler products on the market. We cannot, as a policy,
officially recommend third-party software or hardware. It seems, from the feedback of
many developers, that this decision is based on personal preference. Your best bet would

be to ask the developers themselves on our on-line services, or contact a software
reseller for this information.
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Where have the transitions and sounds gone when | export my Director movie to
digital video?

Many of the score-based transitions of Director will not export to QuickTime on the
Macintosh, or AVI on Windows. You can experiment with increasing the chunk size and
duration of some of them, but many will not convert with the file. When a frame-based
Director animation is converted to a time-based QuickTime of AVI file, many of these
transitions are lost along the way.

As for sounds, the export to AVI from Director for Windows does not support sound.
Exporting sound with the Director animation to QuickTime on the Macintosh can vary in
reliability. Success in doing this is affected by the sound format, available resources on
the machine, where the sound is placed in the score and many other factors, none of
which are constant.

The best technique is to export only the animations from Director. You should add the
transitions, and sounds if you would like, in your favorite digital video editing tool.
SoundEdit 16 is a nice complement when editing the sound of a QuickTime movie on a
Macintosh. You can choose keyframes in the QuickTime movie, synchronize parts of the
wave form to those frames, and save the QuickTime movie once again.
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In Director for Windows, why does the controller of my QuickTime for Windows file
stay on the stage when | jump to a new frame? Or, on the Macintosh, why does
the last frame of the digital video file stay on the screen when | jump to a new

frame?

In Windows, digital video plays directly to the screen buffer, on top of Director's
compositing engine. You can turn this property off on the Macintosh, but not in Windows.
It is a good technique on the Macintosh, however, to select Direct to Stage in the Cast
Member Properties dialog box for the QuickTime movie. This way, the video can play on
the top layer, above the other sprites.

When the video plays direct to stage, Director does not know that the movie is there, and
therefore does not redraw the stage when jumping to a new frame. You will see an
artifact of the video when you jump to a new frame if you do not remove it yourself.

There are many techniques you can use to redraw the stage yourself. Here is one
example:

on exitFrame
set the visible of sprite X to FALSE
--X 1is the channel where the video is placed
updatestage
end
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How can | make digital video files play as well as they do outside of Director?

If you are having trouble with the performance of a digital video file in Director, you
should:

1. Play the digital video file in Apple's MoviePlayer or the Windows Media Player. Make
sure it runs to your satisfaction outside of Director.

2. After importing the file into Director, play it in the video window. You can access this
window by double-clicking on the digital video file in the Cast window. If the file plays
poorly from there, it will not play well in the score. If you are having troubles with the
file, you should return to the MoviePlayer or Media Player to see if the file is intact.

3. If you are on the Macintosh, select Direct to Stage in the Digital Video Cast Member
Info dialog box for the QuickTime movie. (Digital video is always Direct to Stage on
Windows.)

4. Place the video in the score. In the script channel for that frame, type:

on exitFrame
go to the frame
end

It is important to use this "go to the frame" loop to keep Director's playback head
moving in that frame.

If you would like to loop in that frame until the digital video is done playing, you can
use this script:

on exitFrame

if the movieRate of sprite channelNumber
then go to the frame
end

For a list of all of the digital video Lingo terms, see the Lingo digital video topic.
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How do I find the movie script?

With the functionality of Director 5 to support more than one movie script, there is no
one way to find "it," since there can be more than one of them. Once you create a movie
script, you will find it in the cast window, but some ways to find it initially include:

* Press Ctrl-Shift-U.
» In the Window menu, select the script window.
. If you're in a score script, click the Add (+) button.
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How do | use a custom cursor in Director?

In order to use a custom cursor in Director, there are only a few steps to follow. The
Director Learning Lingo book covers this issue. For some reason, thought, it still stumps
many people, so here is a list of the rules to follow:

1. The cast member you use for your custom cursor must be 1-bit (black and white.
You can verify this in the bottom left hand corner of the paint window.

2. Your Lingo syntax needs to be correct. You have two options of how to do this. Here
are some sample scripts to illustrate this:

You can use the "cursor" command:

on startMovie
cursor [5]
--your cursor is in cast #5 and would be
-—-active for the entire movie

end

You can use the "cursor of sprite" command:

on enterFrame
if rollover (2) then
--the sprite you rollover is in channel 2
set the cursor of sprite 2 to [5]
--your cursor is in cast #5
end if
--only when sprite 2 is rolled over
end

on exitFrame
go to the frame
end
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What is a mask cast member, and how do | make one?

When you use a custom cursor, the areas that are white in the black & white area will be
transparent when rolling over other sprites. In order to make the white areas opaque,
you will need to make a mask cast member. The Macintosh system watch cursor is a
good example of this.

Here is one technique to do so:

1.
2.
3.

Duplicate your custom cursor cast member in the cast window.
Double-click that cast member and bring it up in the paint window.

Select the pencil tool (after zooming in) and draw a one-pixel circumference around
the bitmap, making it one pixel thicker than the other bitmap.

Take the paint bucket tool and fill the white areas with black.

The paint bucket tool may do the trick. In order to have the white area be opaque
over other sprites, there needs to be opposition of black and white pixel when the
two cursors are used together.

Again, make sure this cursor is set to 1-bit after editing.
Make sure this cast member is in the cast position following the custom cursor.
Add it to your syntax. For example:

set the cursor of sprite 2 to [5,6]

--where the cursor cast member is in cast #5
--and the mask cast member is in cast #6



.
I have a rollover test in a frame that works properly, but when | jump to a new
frame, that rollover area is still being evaluated even though the sprite is no
longer there. This also happens with the cursor of sprite property.

These tests for the mouse position, or "hot" areas, actually refer to sprite channel
characteristics, and not to individual sprites. If the channel used to hold the sprite being
rolled over alternates between empty and full, unexpected results may occur.

There are at least three ways of working with this:

1. One is to keep channels full in all frames. You can move all the frames next to one
another and delineate them with markers.

2. Another approach would be to create a one-bit "dot" cast member using the tools
window. (This would take up very little memory.) Put an instance of the "dot" in the
empty frames of the sprite channel being used to test for the rollOver.

3. You can also scoot the sprite off-stage, up above the menu bar, to give it an off-
screen position before removing it from the stage.

This issue is similar to setting the cursor of sprite, as mentioned in the Lingo
Dictionary. The cursor property will stay in effect until you turn it off by setting the cursor
to zero.



L
Where is a list of keyCodes?

The keyCode function returns the numerical code for the last key pressed. (This
keyboard code is the key's numerical value, not the ASCI value.)

There is not a list of keyCodes available in the Director documentation. It is easy to
generate a keyCode yourself, though, by creating a one-frame test movie with these
scripts:

In the movie script, type:

on startMovie
set the keyDownScript to "put the keyCode"
end

In the frame script of frame 1, type:

on exitFrame
go to the frame
end

When you play the movie, leave the message window open and the keyCode for any key
you type will appear in the message window. Make sure that the message window is not
the active window, or the keys you press will not be evaluated correctly.

To test for keys in the numeric keypad, you will need to test the keyCodes from a
projector and put the keyCode into a text field. It is necessary to test for certain
modifier keys specifically with Lingo (i.e. the controlDown, the shiftDown, etc.)

These keyCodes are standard on Macintosh keyboards, but might not be standard across
IBM-compatible keyboards. We have not, however, come across a nonstandard keyboard
here in technical support.
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How do | find the letter of a CD drive in Director for Windows?

Crossing drive volumes is more difficult in Windows than on the Mac. On the Mac, you
can just say:

play movie "MyCD:Data:MovieA"

Any mounted volume with that name and path will work automatically. On Windows,
though, the path may be "G:\MyCD\Data\MovieA" or "D: \MyCD\Data\MovieA" or
whatever. Each end user's machine could have the hard drive on a different drive letter.

The following handler will help in finding the actual drive letter for the CD drive. It
assumes that you have a uniquely named file that you pass to the handler (here called
"weirdfil.txt") at the root level of your CD drive. It will successively search for the file
by that name on the root of each drive letter (A to Z) in the alphabet, then return the
letter name of the CD volume it finds the file on.

The script would look like:

put CheckDrive ("weirdfil.txt") into myCD

The return would be the drive letter followed by a colon. This handler begins looking at
drive C, since the chances of both A and B drive being floppy drives is very high.

on CheckDrive weirdfil
-- Note: use your actual filename instead of "weirdfil"
-- throughout this handler
repeat with I = 66 to 90
set drive = numToChar( I )
set myThisPath = string(drive & ":\"& weirdfil)
set myFile = fileIO (mNew, "read", myThisPath)
if objectP (myFile) then
myFile (mDispose)
return drive&":"
exit
end if
end repeat
alert "Please check that"&&QUOTE&welirdfil&QUOTEG&&—
"is on your CD drive."
end



How can | play a Director movie on a hard disk and keep its content
on a CD-ROM?

Here are some tips on how to play your Director movie from a hard disk while keeping its
content on the CD-ROM:

Make sure linked cast members are all on one volume, and save the movie onto the
same volume. This allows a relative pathname to be constructed at playback.

In the movie script, determine the drive letter of the CD-ROM, probably using a
custom Xtra.
Construct a string starting with the drive letter of the CD-ROM, and the rest of the

path duplicating the directory hierarchy where the movie was saved. This allows the
relative paths constructed in the first step to remain usable.

setAt the searchPath, 1, <<the constructed string>>

This tells Director to search for files on the CD-ROM, beginning at the named
directory.

If some of your content or subsidiary movies are on the hard disk, you will want to
search the hard disk first, before looking at the CD-ROM. Most likely, these searches
will be relative to the directory that the movie was launched from. This is how the
searching will work, as set up above.

If you know that all your content and subsidiary movies are on the CD-ROM, you can
dispense with searching the hard disk, saving at least one disk access:

set the searchCurrentFolder to FALSE

This will bypass searches relative to the current directory before scanning through
the searchPath.
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Basic information regarding distribution of "Made with Macromedia"

titles

Macromedia's royalty-free licensing policy means that you can distribute applications
created with Director or Authorware to millions of end-users on multiple platforms--free.
Simply include the Made with Macromedia logo on your product's packaging and credit
screen, complete the Run time distribution agreement, and register your product with
Macromedia to qualify.

This is meant to give a quick overview of the Made with Macromedia Run-time
distribution agreement and answer frequently asked questions. It is not, however, a
replacement for the actual agreement. Please refer to the Made with Macromedia (MwM)
folder on your product CD for the Run-Time distribution agreement, logos, and logo usage
guidelines.



Who needs to comply with the Made with Macromedia logo
requirements?

Any user of Authorware or Director who creates an End-user Product and distributes it
outside of his own organization or anyone who causes an End-user Product to be created
and distributed outside of his own organization. You must fill out Exhibit A of the Run
time distribution agreement and place the Made with Macromedia logo on the outer most

front, side, or back of the packaging and within the software on either a splash or credits
screen.



L
What if the Macromedia runtime is an insubstantial part of a

commercially distributed software product that was not Made with
Macromedia?

You do not need to place the Made with Macromedia logo on the outside of the
packaging, but you will need to put the logo onscreen within the software that makes use
of a Macromedia run-time. You must sign and return the Run-time distribution
agreement, fill out Exhibit C, "Product Qualifying for Limited Markings," and place the

Made with Macromedia logo on the splash or credits screen only. (You do not have to
place it on the packaging.)
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| am using Shockwave™ to add multimedia to my web site. Am |
required to use the Made with Macromedia logo on my "Shocked"
Web Site?

No. This is a benefit to help inform your viewers that your site contains cutting edge
multimedia content. Viewers will be directed to the Shockwave Plug-In so they can view
the Macromedia-created movies within your web site. Macromedia will publish a list of
shocked web sites on our web site, thus increasing the visibility of your site.
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I qualify for either full or partial marking of the Made with
Macromedia logo. What are the steps | need to take to comply with
this agreement?

1.

Complete, sign, and return one copy of the Run-time Distribution Agreement and
either Exhibit A or C that are located in the Made with Macromedia folder of the
Director or Authorware product CD. Exhibit A is for products that qualify for full
marking and Exhibit C is for products that qualify for limited, software only, markings.
The agreement becomes effective upon receipt by Macromedia. For multiple products
or future products, you need only fill out and return an additional copy of Exhibit A or
C. Each additional copy of Exhibit A or C will become effective upon receipt by
Macromedia.

If you qualify for full markings, you need to place the Made with Macromedia logo on
the outside of the packaging and on screen within the software. Logos are located in
the Made with Macromedia (MwM) folder of your Authorware or Director product CD.
See Exhibit B of the Run Time Distribution Agreement for detailed size and location
guidelines. If you qualify for limited markings, you must place the Made with
Macromedia logo on screen only within the software guidelines outlined in Exhibit B.
Incorporate the following copyright statement into the copyright screen of the end-
user product.

- (If Authorware was used to create the Publisher Product)
AUTHORWARE ® COPYRIGHT © 1993 Macromedia, Inc.

- (If Director was used to create the Publisher Product)
DIRECTOR ® COPYRIGHT © 1994 Macromedia, Inc.

Send Macromedia two (2) copies of the final, packaged end-user software within 30
days of ship to:

Macromedia Developer Relations
600 Townsend Street
San Francisco, CA 94103
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Click a letter (above) to view Lingo elements alphabetically.

Or select one of the categories below to see a list of relevant Lingo elements:

Cast members
Casts
Code structures & syntax

Computer & monitor
Digital video
External files

Fields

Frames

Interface elements

Lingo that has changed in 5.0
Lingo that is outdated
Lists

Math & logical operators
Memory management

Movie control
Movie in a window

Navigation

New Lingo elements
Operators

Parent scripts
Puppets

Score generation

User interaction
Variables

For general information on using Lingo, see the Lingo basics topic.



I BT N [ T

ABCDEFGHIJELMNOPQRSTUYWIXYZ

Click a letter (above) to view Lingo elements alphabetically.

Or select one of the categories below to see a list of relevant Lingo elements:

Cast members
Casts

Code structures & syntax
Computer & monitor

Digital video
External files

Interface elements

Lingo that has changed in 5.0
Lingo that is outdated

Lists

Math & logical operators

Memory management

Movie control
Movie in a window

Navigation

New Lingo elements
Operators

Parent scripts
Puppets

Score generation
Sprites

User interaction
Variables

For general information on using Lingo, see the Lingo Basics topic.

The Lingo menu appears when you click and hold the Lingo button in the script window.
This menu displays the complete set of Lingo commands that you can use to create

scripts for your movie.

Choosing an element from the Lingo menu enters it into a script at the insertion point.
This saves you from typing the command and also eliminates typing.

Note: You can use the Copy command from the Windows Help Edit menu to copy Lingo
examples from the Help topics; then you can paste the example into the Director script

window and modify it for your use.



Lingo is Director's scripting language. Some of the advantages of using Lingo in a movie

include:
L] Providing navigation features that let users play and explore movies in the way they
prefer
. Communication with users by receiving and sending information

Ability to play animation and sound in ways that the score alone can't
Control of fields, sound, and digital video
Creation of child objects

.
*
.
L] Automation of authoring by duplicating manual tasks done by using the interface.
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New Lingo elements

The following elements are new in Director 5.0 or have had functionality added since
Director 4.0:

activeWindow name of CastLib
autoTab of member new

beginRecording number of CastLib
border of member number of castlLibs
boxDropShadow number of members of castlLib
boxType of member on activateWindow
buttonType on closeWindow
cancelldleLoad on moveWindow
case

the castLibNum of sprite on resizeWindow
center of member on rightMouseDown
changeArea of member on rightMouseUp
channelCoun of member on zoomWindow
charPosToloc openWindow
chunkSize of member otherwise
clearFrame pageHeight of member
crop of member paletteMapping
deleteFrame pattern
desktopRectList paletteRef
digitalVideoTimeScale the platform
digitalVideoType of member preLoadMode of CastLib
dropShadow of member preLoadMovie
duplicate(list)

duplicateFrame rect of member
duration of member rightMouseDown, the
editable of member rightMouseUp, the
emulateMultiButtonMouse sampleRate

end case sampleSize
endRecording save castLib
fileName of castlLib score

filled of member scoreSelection
finishidleLoad scriptsEnabled
framelabel scriptType
framePalette scrollByLine
frameScript scrollByPage
frameSoundl scrollTop of member
frameSound2 selection of castLib
frameTempo setCallBack
frameTransition shapeType
frontWindow sound of member
height of member wordWrap of member
idleHandlerPeriod timeScale of member
idleLoadDone trackCount(member)
idleLoadMode trackCount(sprite)
idleLoadPeriod trackEnabled

idleLoadTag trackNextKeyTime



idleReadChunkSize
insertFrame
keyPressed
lineCount of member
linePosTolLocV
lineSize of member
loc of sprite
locToCharPos
locVToLinePos

loop of member
margin of member
media of member
member
memberNum of sprite

trackNextSampleTime
trackPreviousKeyTime
trackPreviousSampleTime
trackStartTime(member)
trackStartTime(sprite)
trackStopTime(member)
trackStopTime(sprite)
trackText

trackType (member)
trackType (sprite)

transitionType of member
type of member
unloadMovie
updateFrame

updatelock
windowPresent
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Lingo that is outdated in version 5.0

The following elements are obsolete and no longer supported:

birth
instance
factory
closeDA
openDA

when. . .then constructs
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Lingo that has changed in version 5.0

The following terms have been revised to keep terminology clear now that Director has
multiple casts. The older terms are still supported, but they will become obsolete and

should be avoided:

Director 4.0 Term

backColor of cast
cast
castmembers
castNum of sprite
castType of cast
center of cast
controller of cast
crop of cast
depth of cast
duplicate cast
duration of cast
erase cast
fileName of cast
foreColor of cast
frameRate of cast
height of cast
hilite of cast
loaded of cast
loop of cast
modified of cast
move cast

name of cast
number of cast
number of castmembers
palette of cast
picture of cast
preLoad of cast
preLoadCast
purgePriority of cast
scriptText of cast
size of cast
sound of cast
text of cast
textAlign of field
textFont of field
textHeight of field
textSize of field
textStyle of field
video of cast
width of cast

Director 5.0 Term

backColor of member
member

number of members
memberNum of sprite
type of member
center of member
controller of member
crop of member
depth of member
duplicate member
duration of member
erase member
fileName of member
foreColor of member
frameRate of member
height of member
hilite of member
loaded of member
loop of member
modified of member
move member

name of member
number of member
number of members
palette of member
picture of member
preLoad of member
preLoadMember

purgePriority of member

scriptText of member
size of member
sound of member
text of member
alignment of member
font of member

lineHeight of member
fontSize of member

fontStyle of member
video of member
width of member
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Child-parent scripts

A child object is a self-contained, independent copy of the handlers and variables in a
parent script. Each group of child objects has its own behaviors and values for variables
and properties:

. The handlers work the same as other handlers in Director.

. The property settings and variables can be set and tested the same way as the Lingo

properties and variables you've already worked with.

A parent script contains three types of Lingo:
L An on new handler, which creates the new child object and sets its initial values
when the handler is called. (The term me serves as a local variable that contains the child
object itself and provides a placeholder for the child object in Lingo statements.)

» Optional additional handlers that control the child object's behavior and properties
after the child object is created.
» An optional statement that declares which variables are property variables--variables

for which each child object can maintain individual values regardless of the values for other
child objects.

The new function creates a new child object when it uses the name of a parent script, as
in the following syntax:

new (script "scriptName", argumentl, argument2, argument3...)

The new function can be issued from anywhere in the movie. You can customize the child
object by changing the variable name and values of the arguments in the new statement.

An ancestor is an additional parent script whose handlers are available to a child object.
A parent script makes another parent script its ancestor by assigning the script's name to
the ancestor property. For example, the following statement makes the script Ancestor
Ball Script an ancestor:

set ancestor to new(script"Ancestor Ball Script", listPosition)

See "Parent and child scripts" in Learning Lingo and the ancestor and parent scripts in
the movie MECH for more information about child objects.

. actorList and ancestor properties; new function; me keyword
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Event message hierarchy

Each message has a set series of scripts that it goes to after the message is sent.
Different messages are sent to different types of scripts. The following table lists the
order of objects that each type of message is sent to:

This message: Is sent to this series of scripts:

mouseDown, mouseUp Primary event handler, sprite, cast member, frame,
and then movie script

keyDown, keyUp Primary event handler, sprite, cast member, frame,
and then movie script

enterFrame, exitFrame Frame and then movie script

idle Primary event handler and then movie scripts

startMovie and

stopMovie handler Movie scripts

activateWindow, closeWindow,
openWindow, resizeWindow,

zoomWindow Movie scripts
Custom handler calling
statements Movie scripts

For more information about strategies for placing handlers, see Chapter 1, "Script
Basics," in Learning Lingo.

» on activateWindow, on closeWindow, on enterFrame, on exitFrame, on idle,

on keyDown, on keyUp, on mouseDown, on mouseUp, on openWindow, on
resizeWindow, on startMovie, on stopMovie, on zoomWindow




L
Puppeting

By making a score channel a puppet, you can tell Director to ignore the score's settings
for that channel and control the channel directly from Lingo. In a sense, the channel is a
puppet and Lingo pulls the strings.
» For sprites and sounds, the channel remains a puppet until you use a statement to
return control to the score. The statement you use depends on whether the channel is a
sprite channel or a sound channel.

L For tempos and palettes, the puppet condition lasts until the playback head enters a
frame that has a new palette or tempo setting.
- For transitions, the puppet condition applies only to the specific instance in which the

puppet transition is used.

For details about using one of these commands, see that command's entry in the online
help.

L puppetPalette, puppetSound, puppetSprite, puppetTempo, and
puppetTransition commands




L]
Handling text

Director has two types of cast members dedicated to text:
. Text cast members can be edited and formatted in the text window but not on the
stage or from Lingo. This type of text is static after the movie is converted to a projector.
Although text cast members are useful for displaying text that has been previously
formatted as rich text, they can't receive user input or change formatting after the movie is
distributed.
L Field cast members can be edited on the stage and from Lingo while the movie plays.
This lets you make movies in which the user can type characters and have Director manage
them. Strings in a field cast member can be revised as the movie plays, and Lingo can
format characters at any time.

A variety of field cast member properties determine the format of characters in the field
cast member. For a list of properties that you can set, choose Fields from the categorized
Lingo menu in the script window.

Lingo duplicates the ability to make a field editable by setting the editable of sprite
and the editable of member properties. To turn editable fields on or off independent of
the interface, set the sprite or field cast member property to either TRUE or FALSE.

For more information about handling text and fields, see Chapter 6, "Working with Text &
User Input," in Learning Lingo.



L]
Controlling sound

Lingo can control many aspects of how sound plays in a movie. Using the puppetSound
command, you can override the score and play a sound cast member from Lingo.
However, Lingo can also control how sound plays. The following table lists additional
ways that Lingo can control sound and the elements that you use to achieve it. For
details about an element, see its entry in the online help:

To do this: Use these elements:
Play an external sound file sound playFile

Check whether a sound channel the soundBusy
is currently playing a sound
and make the movie respond

accordingly
Turn sound off the soundEnabled
Control sound volume from the soundLevel
the movie
Control how sound fades in sound fadelIn
and out and sound fadeOut
L sound playFile, puppetSound, sound fadeln, and sound fadeOut commands;

the soundBusy and soundEnabled properties



L
Using movie in a window

A movie in a window is a distinct Director movie that can be opened by the current
movie. Because it's a Director movie, the movie in a window can keep its Lingo in effect.

You create a window by specifying the screen rectangle for the window and then
specifying the movie assigned to the window. You can also make the window visible,
change its type, set its title, or set the window's size and location.

Besides specifying which movie plays in the window and when the window opens and
closes, you can control the behavior of the window itself and how movies in windows
interact with the movie on the stage.

The following lists the Lingo elements you use to achieve different tasks for playing a
movie in a window. For details about an element, see its entry in the online help:

To: Use:

Set up a rectangle for the movie  set the rect of window "whichWindow" to
rect (coordinates)

Assign a movie to the window set the fileName of window "whichWindow"
to "fileName"

Specify whether the window
title is visible set the titleVisible of window
"whichWindow" to trueOrFalse

Open the window that contains

the movie open window "whichWindow"

Determine the window type set the windowType of window
"whichWindow™"

Move the window to the front moveToFront window "whichWindow"

Move the window to the back moveToBack window "whichWindow"

Make the window visible set the visible of window "whichWindow"

Pass Lingo statements between

windows tell "instructions"

Close the window close window "whichWindow"

For an example of how these elements are used together to create a movie in a window,
see Chapter 9, "Movies in a window," in Learning Lingo.

> open window, close window, moveToFront, and moveToBack commands; the
fileName of window, the titleVisible of window, the visible of window, and the

windowType of window properties




L]
Using variables

Director remembers and updates values by using variables. As the name implies, a
variable contains a value that can be changed or updated as the movie plays. By
changing the value of a variable as the movie plays, you can do things such as store
information the user enters or record whether a specific event has happened.

The value assigned to the variable can be a whole number, a decimal number (such as
1.56), a character string (such as "xyz" or a person's name), or the result of a calculation.

Assigning values to variables

Assign a value--such as a number or a character string--to a variable with the set or the
put ... into command. For example, the statement

put "Mary" into theName
assigns the string "Mary" to the variable vName.

Some possible sources for values assigned to variables are strings that the user types,
the result of an arithmetic operation, and the result of clicking a particular sprite.

Creating variables
A variable is created the first time you assign a value to it, which is also called initializing
a variable. You can then use the variable in other expressions or change its value based
on whatever criteria you want. A variable can be a global variable or a local variable.

Global variables

Global variables can be shared among handlers and movies. The global variable exists
and retains its value for as long as Director is running or until you issue the clearGlobals
command.

You make a variable global by using the term global before the variable name in every
handler that uses the global variable.

Every handler that declares that a variable is global can use the variable's current value;
if the handler changes the variable's value, the new value is available throughout the
movie. Variables that you declare in the message window are automatically global.

For example, to use someone's name several times in a movie, you could establish a
global variable that contains a nhame entered by the user at the beginning of the movie.

The following statements makes theName a global variable and give it the value Mary:

global gName
put "Mary" into gName

Later in the movie, this handler could change the name assigned to this variable to
"John." The variable can be changed from two different handlers because each handler
treats the variable as global:

on nameChange



global gName
put "John" into gName
end

It is a good habit to start the names of all global variables with a small letter "g". This
helps identify which variables are global when you examine Lingo code.

To display all current global variables and their current values, use the showGlobals
command in the message window.

Local variables

A local variable exists only as long as the handler in which it is defined is running. You
can use a local variable in any handler, but it is available only while that handler is
running.

Unless the handler uses the term global to declare that a variable is global, the variable
is automatically a local variable.

You can display all current local variables in the handler by using the showlLocals
command. This command can be used in the message window or in handlers to help with
debugging. The result appears in the message window.

Treating variables as local is a good idea when you only want to use the variable
temporarily in that one handler. This helps avoid unintentionally changing the value in
another handler that uses the same variable name.

global keyword, clearGlobals, showGlobals, put, and set commands




L
Types of scripts

A script's type is determined by where it is assigned in the movie. The type of script in
which you place Lingo can affect the script's behavior.

There are four types of scripts:

L Score scripts are assigned to cells in the score. A score script assigned to a sprite is
called a sprite script. A score script assigned to a frame's script channel is called a frame
script.

Sprite scripts can respond to mouseDown and mouseUp events and to keyDown and
keyUp events if the sprite is a field.

Frame scripts can respond to mouseDown and mouseUp events, keyDown and keyUp
events (if the sprite is a field), and enterFrame and exitFrame events.

Director automatically assigns numbers to new score scripts. These numbers appear
in the Script pop-up menu and in the cells that the script is assigned to. When you revise a
score script, the changes show up everywhere the script is assigned in the score.

. Scripts of cast members are assigned directly to a cast member independent of the
score. Scripts assigned to cast members can respond to mouseDown and mouseUp events
and to keyDown and keyUp events if the cast member is a field.

. Movie scripts aren't assigned to a specific object but are available to the entire
movie. Scripts assigned to the movie can respond to mouseDown and mouseUp events,
keyDown and keyUp events (if the sprite is a field), enterFrame and exitFrame events,
startMovie and stopMovie events, and idle events.

L Parent scripts are a special type of script that contains Lingo used to create child
objects. For information about parent scripts, see Child-parent scripts.

The title bar at the top of the script window tells the script's type.

Score, movie, and parent scripts exist as full-fledged cast members in the cast window.
You can change one of these script's type to one of the others by choosing from the Type
pop-up menu in the Script Cast Member Properties dialog box.

L Event message hierarchy




Managing memory

Loading cast members that require a large amount of memory can cause undesired
pauses in a movie.

Lingo helps you minimize these pauses by controlling when specific cast members are
loaded, setting how many bytes Director attempts to load at one time, and prioritizing
when Director unloads them.

For more information, see the entry for individual Lingo elements that can manage

memory. For a list of elements related to memory management, choose Memory
Management from the features menu in the script window.

preLoad, preLoadMember commands; purgePriority of member property



L]
Working with casts

Lingo uses the castLib keyword, followed by a cast's name, to identify a cast. For
example, in the statement set the text of member "Title" of castLib "News" to
"Calendar" it uses castLib to identify the cast News.

When you want to change a movie's content by switching casts, you can change the cast
assigned to a sprite by changing the sprite's castLibNum property. The sprite then uses
the cast member that has the same cast member number in the new cast.

When you want to replace a movie's content by replacing its casts, you can make the
casts external casts and overwrite the cast files with new cast files. Of course, each new
cast file must have the same name as the cast file it replaces.

The following Lingo elements are useful for obtaining information about casts:

castLib

fileName of castLib

findEmpty

name of castLib

number of castLib

number of castLibs

number of members of castLib

preLoadMode of castLib
save castLib

castLib keyword; purgePriority of member



L
Sprite properties

Using Lingo's sprite properties, you can check a sprite's current conditions and change many
of them. For a complete list of sprite properties, choose Sprites from the Lingo features
menu in the script window. For more information about a specific property, such as whether
it can be set from Lingo, see the property's entry in the online help.

The following properties can be set from Lingo provided that the sprite channel has been put
under Lingo's control by the puppetSprite command:

backColor memberNum
blend moveableSprite
castLibNum pattern
constraint scoreColor
cursor scriptNum
editable spriteBox
foreColor stretch
height trails

in top

lineSize visible

locH width

locV

» the and sprite keywords; put, puppetSprite, and set commands



Generating score

Lingo duplicates manual tasks that you perform in the score--such as selecting frames,
specifying what's in each channel, and animating sprites over a series of frames--by
creating a new frame and then specifying each channel's content. It repeats this, frame
by frame, until the entire sequence of frames is set up.

You can add new frames, edit frames, or delete frames.

To start recording score, you must issue the beginRecording keyword. When you are
done recording score, you must issue the endrecording keyword.

Lingo can specify each channel's content during a score recording session. The following
lists what Lingo can set for each channel:

Channel Lingo that can set the channel's content

Label the frameLabel

Tempo the frameTempo

Palette the framePalette

Transition the frameTransition

Sound channel 1 the frameSoundl

Sound channel 2 the frameSound2

Script the frameScript

Sprite channels Sprite properties such as memberNum of sprite, locH and

locV, and moveable of sprite. (Assign a sprite script by
setting the scriptNum of sprite.)

When the frame's content is complete, use the updateFrame command to enter the new
content. The updateFrame command makes a copy of the current frame, inserts it as the
next frame, and then advances to the new frame. After Director has entered the new
frame, you can specify that frame's content.

Several commands are available to add or delete frames. The following table lists these
commands and their result:

Command Result

clearFrame Deletes everything in the current frame, but remains in the
frame.

deleteFrame Deletes the current frame. The next frame then becomes the
current frame.

duplicateFrame Duplicates the current frame and its content. The duplicate

frame is inserted after the current frame and then becomes the
current frame.



insertFrame Inserts a copy of the current frame following the current frame.
The new frame then becomes the current frame.

updateFrame Enters the changes made to the current frame. The command
then makes a copy of the current frame, inserts it as the next
frame, and then advances to the new frame.

For more information about generating score from Lingo, see Chapter 11, "Creating
movies from Lingo," in Learning Lingo.

» clearFrame, and deleteFrame, duplicateFrame, insertFrame, and
updateFrame commands; the updateLock movie property




L]
Writing scripts

You write scripts in the script window. The following are common ways to perform basic
tasks for creating, assigning, and opening scripts:

To:

Open a new score script

Open a new movie script
Assign a score script to one
or more cells in the score

Enter and edit text

Remove a score script
from the cell

Change a script window's type

Cycle through the scripts in
the script window

Open the script assigned
to a cast member

Open a score, movie, or
parent script

Open a score script from
the score

Open a score, movie, or
parent script

Do this:

Choose New Script from the Script pop-up menu;
or select a score cell and then click the script
preview button. When you open a new score
script, the script receives the number of the first
available location in the cast window.

Click the plus sign in the script window

Select the cells in the score and then choose
the score script number from the Script pop-up
menu.

Click in the script window and follow basic text
editing techniques to type, select, delete, and
copy text.

Select the cell and then choose Clear Script
from the Script pop-up menu.

Open the script's Cast Member Properties and
then choose a type from the Type
pop-up menu.

Use the forward and reverse arrows at the
top of the script window to advance or back up to
the script.

Click Script in the Cast Member Properties
dialog box; select the script in the cast window
and then click the script button at the top of the
cast window.

Double-click the script in the cast window.
Select the cell and then click the script
preview button.

Select the script and choose Duplicate from
the Edit menu

Script window and Types of scripts



L]
Using Xtras

Xtras are software modules that extend Director's functionality. An Xtra file can contain
one or more such modules. There are four types of Xtras:
L] Transition Xtra cast members, which supply transitions in addition to predefined
transitions available in the Frame Properties:Transition dialog box. After they are used in the
score's transition channel, they appear in the cast window the same as any cast member.
An Xtra transition cast member can have its own custom properties, properties dialog
box, animated thumbnail, cast window icon, and About box. Open the dialog box that sets
properties by opening the Frame Properties:Transition dialog box and then clicking Options.
L Xtra cast members, which can be a wide range of objects such as databases, text
managers, or special graphics. They appear in the Insert menu after the Xtra is loaded. An
Xtra can create more than one menu item if it is designed to do so.
Add an Xtra cast member to a cast by choosing the Xtra from the Insert menu. Cast
member Xtras are sometimes called sprite Xtras because they can be assigned to the score
after they are in the cast window.

An Xtra cast member can have its own custom properties, properties dialog box,
media editor, animated thumbnail, cast window icon, and About box. Open the dialog
box that sets the Xtra's properties by opening the cast member's Properties dialog
box and then clicking Options. Open the Xtra's media editor by double-clicking the
cast member's thumbnail in the cast window.

L Lingo Xtras, which add Lingo elements to Director's built-in Lingo.

- Tool Xtras, which you can use during authoring. To open a tool Xtra, choose it from

the Xtras menu.

Providing Xtras

When Director launches, it automatically registers Xtras that are in either of two places:
» The Xtras folder in the same folder that contains the Director application or projector
- One of the following folders, depending on which platform Director is running on:
For Windows 95 and Windows NT, the Xtras folder in the Program Files\Common Files\
Macromedia\Xtras folder
For Windows 3.1, the Windows\Macromed\Xtras folder
For Macintosh and Power Macintosh, the System Folder:Macromedia:Xtras folder.

To make an Xtra available, place its file in one of these folders before you launch
Director. (The Xtra can be in a folder within the Xtras folder up to five layers deep.)
Director also automatically closes these Xtras when the application quits.

You can also open Lingo Xtras after Director is running by using the openxlib command.
The Lingo Xtra can be in any folder if you open it this way. However, you must use the
closexlib command to close the Xtra after Director is finished with it.

Xtras aren't packaged in projectors. The Xtras must be in an Xtras folder in the same
folder as the projector or an Xtras folder that is valid for the current operating system.

If an Xtra that the movie uses is missing, an alert appears when the movie or external
cast file opens. For missing Xtra transition cast members, the movie performs a simple
cut transition instead. For other missing Xtra cast members, Director displays a red "X"
on the stage as a placeholder for the missing Xtra.

Copies of the same Xtra can have different filenames or have the same filename but
reside in different folders. If they are used in the same movie, Director detects that such
Xtras are duplicates and displays an alert. You can avoid this situation by just deleting



any duplicate Xtras if this occurs.

Creating Xtras by using the new function

You can create a new instance of an Xtra by using the new function. The specific way you
do this depends on the Xtra's type.

You can create new transition Xtras and cast member Xtras just as you can built-in cast
members. For transition cast members, use new and the symbol #transition. Other cast
member Xtras have their own symbols specified by the developer.

For example, a QuickDraw 3D cast member could be given the symbol #quickDraw3D. In
this case, to create a new cast member, you'd use the statement new (#quickDraw3D).

This statement creates a new instance of the Xtra cast member which has the symbol
#math:

new (#math)

After the cast member is created, you can assign it content the same way as you do for
other castmembers.

You create new instances of Lingo Xtras by using the new function and the term xtra as
the first parameter. For example, this statement creates a new instance of the Lingo Xtra
stringReader:

set stringl = new(xtra "stringReader")

For instances of Lingo Xtras created by using the new function, you must set the variable
that contains the Xtra to 0 before you use the closexlib command to delete the Lingo
Xtra.

See Chapter 11, "Authoring from Lingo," for more information about creating cast
members from Lingo.

Checking which Xtras are available

Lingo can tell you how many Xtras are available, the name of each, and what each Xtra
contains.

The number of xtras property indicates how many Xtras are available in the current
movie.

The name of xtra property determines the name of a specific Xtra. The name of xtra
property can be tested and set.

For example, the following repeat loop displays the name of each Xtra in the message
window:

repeat with counter = 1 to (the number of xtras)
put the name of xtra counter
end repeat



The showXLib command displays each Xtra file and its contents. For example, suppose
that a Lingo Xtra Friends is in the folder c:\Xtra Reserve. If the Xtra file Friends contains
the modules Fred and Joe, the showXlib command would give the following results:

c:\xtra reserve
xtra Fred
xtra Joe

Use mMessagelList to display message with information about the Xtra. For example, the

statement put mMessageList (xtra "Fred") displays information about the Xtra Fred.
For more information on Xtras

For a listing of Xtras available for Director, see the Macromedia Web site at

http://www.macromedia.com. You will also find information on the Xtra Developer's Kit
(XDK).
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Lingo elements--navigation

Click a Lingo element for more information:

continue

delay

go loop

go next

go previous
go

marker
pause

play

play done
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Lingo elements--movie control
Click a Lingo element for more information:

movieName
on startMovie

on stopMovie
play

play done
saveMovie

score

stage
stageBottom
stageColor
stageleft
stageRight
stageTop

switchColorDepth
updateMovieEnabled
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Lingo elements--user interaction

Click a Lingo element for more information:

clickLoc mouseDownScript
clickOn mouseH
commandDown mouseUpScript
controlDown mouseV

cursor moveableSprite of sprite
cursor of sprite on keyDown
doubleClick on keyUp

key on mouseDown
keyCode on mouseUp
keyDownScript optionDown
keyUpScript rollOver

lastClick shiftDown

lastKey

lastRoll

loc of sprite
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Lingo elements--computer & monitor

Click a Lingo element for more information:

beep
beepOn

colorDepth
desktopRectlList

floatPrecision
machineType
mci
multiSound
quit

restart

romanlLingo
version
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Lingo elements--memory management
Click a Lingo element for more information:

cancelldleLoad
finishidleLoad
freeBlock
idleLoadDone
idleReadChunkSize
loaded of member
memorySize
movieFileFreeSize
movieFileSize
preLoad

preLoad of member
preLoadEventAbort
preLoadMember
preLoadMode of CastLib
preLoadRAM

purgePriority of member
ramNeeded
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Lingo elements--casts
Click a Lingo element for more information:

castLib

fileName of castLib

findEmpty

name of CastLib

number of CastLib

number of castLibs

number of members of castLib
preLoadMode of CastLib

save castLib
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Lingo elements--cast members
Click a Lingo element for more information:

center of member

crop

duplicate member
erase member

fileName of member

height of member

importFilelnto
media of member

member

new

number of member
rect of member
type of member
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Lingo elements--sprites
Click a Lingo element for more information:

backColor of sprite
constrainH

constraint of sprite
constrainV

cursor of sprite
foreColor of sprite
height of sprite
ink of sprite

left of sprite

loc of sprite
memberNum of sprite

moveableSprite of sprite

paletteRef
puppetSprite
scriptNum of sprite

stretch of sprite
type of sprite

updateStage
visible of sprite
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Lingo elements--frames
Click a Lingo element for more information:

frame
framelabel
framePalette
frameScript
frameSoundl
frameSound2
frameTempo
frameTransition
label

marker

on enterFrame
on exitFrame
puppetPalette

puppetTempo
puppetTransition
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Lingo elements--score generation
Click a Lingo element for more information:

beginRecording
clearFrame

deleteFrame
duplicateFrame

endRecording
insertFrame

updateFrame
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Lingo elements--external files

Click a Lingo element for more information:

closeDA open

closeResFile openDA

closeXlib openResFile
copyToClipBoard openXlib

fileName of castLib pathName

fileName of member searchCurrentFolder
getNthFileNamelnFolder searchPath
importFilelnto setCallBack
movieFileFreeSize showResFile
moviePath showXlib

sound playFile
xFactorylList
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Lingo elements--movie in a window
Click a Lingo element for more information:

closeWindow
drawRect of window
fileName of window
forget window
modal of window
moveToBack
moveToFront

open window

rect of window

title of window
visible of window
window

windowlist
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Lingo elements--parent scripts
Click a Lingo element for more information:

actorlList
ancestor
birth

ne

ropert
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Lingo elements--lists
Click a Lingo element for more information:

[1 (list brackets)
add
addAt

addProp

findPosNear

getaProp
getAt
getLast
getOne
getPos
getProp

getPropAt
listP
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Lingo elements--code structures & syntax

Click a Lingo element for more information:

(o]

ase
nd case
nd if
it

o |®

)

if ... then ...

if ... then ... else
repeat while
end repeat
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Lingo elements--strings

Click a Lingo element for more information:

item...of
itemDelimiter
last

length
line...of

number of items in
number of lines in

stringP
word...of
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Lingo elements--math & logical operators

Click a Lingo element for more information:

- _(minus sign) abs
() (parenthesis) and
* (multiplication) atan
+ (addition) charToNum
[_(division) cos
> (greater than) ex
> = (greater than or equal to) FALSE
< (less than) float
< = (less than or equal to) floatP
<> (not equal) integer
= (equal sign) integerP
mod
or
sqrt
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Lingo elements--fields

Click a Lingo element for more information:

alignment of member item...of

char...of lineHeight of member
chars locToCharPos
charToNum locVTolLinePos
contains number of chars in
delete number of items in

dropShadow of member

editable of member
editable of sprite
font of member
fontSize of member
fontStyle of member
foreColor of member

height of member
hilite

number of words in
offset

scrollByPage

string

text of member
wordWrap of member
word...of
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Lingo elements--digital video

Click a Lingo element for more information:

controller of member
duration of member
frameRate of member
loop of member
movieRate of sprite
timeScale of member
trackCount(member)
trackCount(sprite)
trackEnabled
trackNextKeyTime

trackNextSampleTime
trackPreviousKeyTime

trackPreviousSampleTime
trackStartTime(member)
trackStartTime(sprite)
trackStopTime(member)
trackStopTime(sprite)
trackText

trackType (member)
trackType (sprite)




L]
L]
Lingo elements--sound

Click a Lingo element for more information:

puppetSound
sound close
sound fadeln
sound fadeOut
sound of member
sound playfFile

sound stop

soundBusy
soundEnabled

volume of sprite
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Lingo elements--interface elements

Click a Lingo element for more information:

alert
buttonType

checkMark of menultem
enabled of menultem
installMenu

menu

name of menu

name of menultem
number of menultems
number of menus

script of menultem
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Lingo elements--operators

Click a Lingo element for more information:

# (pound sign) < (less than)

- _(minus sign) < = (less than or equal to)

-- (comment delimiter) <> (not equal)

& (concatenator) = (equal sign)

&& (concatenator) > (greater than)

* _(multiplication) > = (greater than or equal to)
+ (addition) [1__(list brackets)

[_(division) " (string constant)

= (continuation symbol)
() [parentheses]
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Lingo elements--puppets

Click a Lingo element for more information:

puppet of sprite

puppetPalette
puppetSound

puppetSprite
puppetTempo
puppetTransition

updateStage
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Lingo elements--time

Click a Lingo element for more information:

date

dela
framesToHMS
HMStoFrames
startTimer
ticks

:

timeoutKeyDown
timeoutlLapsed
timeoutMouse
timeoutScript
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Lingo elements--variables

Click a Lingo element for more information:

clearGlobals
property

put

set...to and set...=
showGlobals
showlocals
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Lingo elements--A

Click a Lingo element for more information:

abbreviated
abort

abs
activateWindow
activeWindow
actorlList

alignment of member
ancestor

and

append

atan

autoTab of member
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Lingo elements--B

Click a Lingo element for more information:

backColor of member

backColor of sprite
BACKSPACE

beep

beepOn

before
beginRecording
birth

blend of sprite
border of member
bottom of sprite
boxDropShadow of member
boxType of member
buttonStyle
buttonType




Lingo elements--C

Click a Lingo element for more information:

cancelldleLoad

case

the castLib

the castLibNum of sprite
center of member
centerStage

changeArea of member
channelCount

char...of
charPosToloc

chars

charToNum
checkBoxAccess
checkBoxType
checkMark of menultem
chunkSize of member
clearFrame
clearGlobals

clickLoc

clickOn

close window

closeDA
closeResFile
closeWindow
closeXlib

crop
colorDepth
colorQD
commandDown

constrainH
constraint of sprite
constrainV

contains

continue
controlDown
controller of member
copyToClipBoard

cos

count

rop of member
cursor

cursor of sprite

(o]




Lingo elements--D

Click a Lingo element for more information:

deleteProp
depth of member

desktopRectlList
digitalVideo
digitalVideo member center

digitalVideo member controller
digitalVideo member crop

digitalVideo member directToStage

digitalVideo member duration

digitalVideo member frameRate

digitalVideo member loop

digitalVideo member pausedAtStart

digitalVideo member preload
digitalVideo member sound

digitalVideo member video

digitalVideo sprite movieRate
digitalVideo sprite movieTime

digitalVideo sprite startTime
digitalVideo sprite stopTime

digitalVideo sprite volume
digitalVideoTimeScale
digitalVideoType
directToStage of member
do

done

dontPassEvent
doubleClick

down
drawRect of window
dropShadow of member
duplicateFrame
duplicate(list)

duplicate member
duration of member




L]
L]
Lingo elements--E

Click a Lingo element for more information:

editable of member
editable of sprite

else

EMPTY
emulateMultiButtonMouse
enabled of menultem

end

end case

end repeat

endRecording
ENTER

enterFrame
erase member
exit

exit repeat
exitFrame
exitLock

exp




L]
L]
Lingo elements--F

Click a Lingo element for more information:

factory font of member
fadeln fontSize of member
fadeOut fontStyle of member
FALSE foreColor of member
field foreColor of sprite
fileName of castLib forget window
fileName of member frame

fileName of window framelabel

filled framePalette
findEmpty frameRate of member
findPos frameScript
findPosNear frameSoundl
finishldleLoad frameSound2
fixStageSize framesToHMS

floatPrecision

frameTempo
frameTransition

freeBlock

freeBytes
frontWindow



L]
L]
Lingo elements--G
Click a Lingo element for more information:

getaProp
getAt
getLast
getNthFileNamelnFolder
getOne
getPos
getProp
getPropAt
global

go

go loop

go next

go previous



L]
L]
Lingo elements--H

Click a Lingo element for more information:

-3
I+

al
height of member
height of sprite
hilite

hilite of member
HMStoFrames




L]
L]
Lingo elements--I

Click a Lingo element for more information:

idle insertFrame
idleHandlerPeriod inside
idleLoadDone inside point
idleLoadMode installMenu
idleLoadPeriod instance
idleLoadTag integer
idleReadChunkSize integerP

if intersect

ilk intersect rect
importFilelnto intersects

in into

inflate rect item...of

ink of sprite itemDelimiter

items



L
L
Lingo elements--)

There are no Lingo elements that begin with the letter .



L]
L]
Lingo elements--K

Click a Lingo element for more information:

key

keyCode
keyDown
keyDownScript
the keyPressed
keyUp
keyUpScript




Lingo elements--L

Click a Lingo element for more information:

label lines

labellist lineSize of member
last lineSize of sprite
lastClick list

lastEvent list operators ([1)
lastFrame listP

lastKey loaded of member
lastRoll loc of sprite

left of sprite locH of sprite
length locToCharPos
line...of locV of sprite
lineCount of member locVToLinePos
lineHeight log

lineHeight of member long
linePosTolLocV loop

loop of member



Lingo elements--M

Click a Lingo element for more information:

machineType
map

map point

map rect

margin

marker
mAtFrame

max

maxinteger

mci

mDescribe
mDispose

me

media of member
member

member backColor

member memberType

member depth
member fileName

member foreColor
member height
member hilite
member loaded
member name
member number

member palette
member picture

member purgePriority
member rect

member regPoint
member scriptText
member text

member width
memberNum of sprite
memorySize

menu

menultem
mRespondsTo

menultems

menus

method

mGet

min
mlinstanceRespondsTo
mMessagelist
mName

mNew

mod

modal of window
modified of member
mouseCast
mouseChar
mouseDown
mouseDownScript
mouseH

mouseltem
mouseline

mouseUp

mouseUpScript
mouseV

mouseWord
move member

moveableSprite of sprite

moveToBack
moveToFront
moveWindow
movie
movieFileFreeSize
movieFileSize
movieName
moviePath
movieRate of sprite
movieTime of sprite
mPerform

mPut

multiSound




L]
L]
Lingo elements--N

Click a Lingo element for more information:

name of CastLib number of CastLib
name of member number of castLibs
name of menu number of chars in
name of menultem number of items in
name of window number of lines in
name of xtra number of member
hew number of members
next number of members of castLib
next repeat number of menultems
not number of menus
nothing number of words in

number of xtras
numToChar




L]
L]
Lingo elements--O

Click a Lingo element for more information:

objectP on resizeWindow
of on rightMouseDown
offset on rightMouseUp
offset rect on startMovie
on on stepMovie

on activateWindow on stopMovie

on closeWindow on timeOut

on deactivateWindow on zoomWindow
on enterFrame open

on exitFrame openWindow

on idle open window

on keyDown openDA

on keyUp openResFile

onh mouseDown openXlib

on mouseUp optionDown

on moveWindow or

on openWindow otherwise



Lingo elements--P

Click a Lingo element for more information:

pageHeight of member preLoad

palette of member preLoad of member
paletteMapping preLoadEventAbort
paletteRef preLoadMember
param preLoadMode of CastLib
paramCount preLoadMovie

pass preLoadRAM
pasteClipBoardinto previous

pathName printFrom

pattern property

pause puppet of sprite
pausedAtStart of member puppetPalette
pauseState puppetSound
perFrameHook puppetSprite

pi puppetTempo
picture of member puppetTransition
pictureP purgePriority of member
platform put

play put...after

play done put...before
playFile put...into

point

ower



L]
L]
Lingo elements--Q
Click a Lingo element for more information:

quickTimePresent
quit
QUOTE




Lingo elements--R

Click a Lingo element for more information:

ramNeeded

random
randomSeed

rect

rect of member

rect of sprite

rect of window

rect point

regPoint of member
repeat while

repeat with
repeat with...in list

repeat with...down to

resizeWindow, on
restart

result

RETURN

return
rightMouseDown
rightMouseDown

rightMouseUp
rightMouseUp
right of sprite
rollOver

romanlLingo




Lingo elements--S

Click a Lingo element for more information:

sampleRate

sampleSize
save castLib

saveMovie

score

scoreColor of sprite
scoreSelection
script of menultem
scriptNum of sprite
scriptsEnabled

scriptText of member
scriptType
scrollByLine
scroliByPage

scrollTop
searchCurrentFolder

searchPath
searchPaths
selection
selection of castLib
selEnd

selStart
setaProp

setAt
setCallBack
setProp

set...to and set...=
setTrackEnabled
shapeType
shiftDown

short
showGlobals
showlocals
showResFile
showXlib
shutDown

sin

size of member

0
+

o
sound close
sound fadeln
sound fadeOut
sound of member
sound playFile

sound stop

soundBusy
soundEnabled

soundLevel
sourceRect
sprite

spriteBox
sprite...intersects

sprite...within

0 |»
~+
kk
(o
(]

stageBottom
stageColor
stageleft
stageRight

stageTop
startMovie

starts
startTimer
stepMovie
stillDown
sto

stopMovie
stretch of sprite
string

stringP
switchColorDepth
symbolP

-



L]
L]
Lingo elements--T

Click a Lingo element for more information:

TAB TRUE

tan to

tell top of sprite

text of member trace

the tracelLoad

then tracelLogFile

ticks trackCount(member)
time trackCount(sprite)
timeoutKeyDown trackEnabled
timeoutlLapsed trackNextKeyTime
timeoutLength trackNextSampleTime
timeoutMouse trackPreviousKeyTime
timeoutPlay trackPreviousSampleTime
timeoutScript trackStartTime(member)
timer trackStartTime(sprite)
timeScale of member trackStopTime(member)
title of window trackStopTime(sprite)
titleVisible of window trackText

trackType (sprite) trackType (member)
trails of sprite type of member

transitionType of member type of sprite



.
Lingo elements--U
Click a Lingo element for more information:

union rect
unlLoad
unLoadMember
unloadMovie

updateFrame
updatelLock
updateMovieEnabled
updateStage



L]
L]
Lingo elements--V

Click a Lingo element for more information:

value

version

video of member
videoForWindowsPresent
visible of sprite

visible of window

voidP

volume of sound

volume of sprite




L]
L]
Lingo elements--W

Click a Lingo element for more information:

when...then

while

width of member
width of sprite
window

windowlist
windowPresent
windowType of window
with

within

word...of

wordWrap of member




L
L
Lingo elements--X

Click a Lingo element for more information:

xFactorylList




L
L
Lingo elements--Y

There are no Lingo elements that begin with the letter Y.



L]
L]
Lingo elements--Z

Click a Lingo element for more information:

zoomBox
zoomWindow



L

# (pound sign)

Syntax: #symbolName
This symbol definition operator defines a symbol. In addition to integers, floating point
numbers, strings, and objects, Lingo also has a symbol data type. A symbolName begins

with an alphabetical character and may be followed by any number of alphabetical or
numerical characters.

The valid operations on symbols are:

. Assignment to a variable

» Comparison

L] Being passed as a parameter to a handler or method

» Being returned as a value from a handler or method.
A symbol is a self-contained unit that can be used to represent a condition or flag. It does
not consist of individual characters in the same sense as a string. However, you can
convert a symbol to a string for display purposes by using the string function.
Symbols take up much less space than strings and can be manipulated. Essentially,
symbols have the speed and memory advantages of integers but give you the
descriptive power of strings.

Example:

This statement sets the variable named state to the symbol #pPlaying:

set state = #Playing

» symbolP function



L
- (minus sign)

Syntax (negation): -expression
This arithmetic operator reverses the sign of the value of the expression.
This is an arithmetic operator with a precedence level of 5.
Syntax (subtraction): expressionl - expression2
This arithmetic operator performs an arithmetic subtraction on two numerical
expressions, subtracting expression2 from expressionl. When both expressions are

integers, the difference is an integer. When either or both expressions are floating point
numbers, the difference is a floating point number.

This is an arithmetic operator with a precedence level of 3.

Example 1 (negation):

This statement reverses the sign of the expression 2 + 3:
put - (2 + 3)

The result is -5.

Example 2 (subtraction):

This statement subtracts the integer 2 from 5, and then displays the result in the
message window:

put 5 - 2

The result is 3, which is an integer.

Example 3 (subtraction):

This statement subtracts the floating point number 1.5 from 3.25, and then displays the
result in the message window:

put 3.25 - 1.5

The result is 1.75, which is a floating point number.



L ]
-- (comment delimiter)

Syntax: -- [comment]

This comment delimiter symbol indicates the beginning of a script comment. On any line,
what is between the comment symbol (double hyphen) and the end-of-line return
character is interpreted as a comment instead of a Lingo statement.

Example:
This handler uses a double hyphen to make the second line a comment:

on resetColors
—-- This handler resets the sprite's colors.
set the foreColor of sprite 1 to 35
-- bright red
set the backColor of sprite 1 to 36
-- light blue
end resetColors



[
& (concatenator)

Syntax: expressionl & expression2

This operator performs a string concatenation of two expressions. If either expressionl or

expression2 evaluates to a number, it is first converted to a string. The resulting
expression is a string.

This is a string operator with a precedence level of 2.

Example 1:

This statement concatenates the strings "abra" and "cadabra":

put "abra" & "cadabra"

The result is the string "abracadabra".

Example 2:

This statement concatenates the strings "$" and the content of the variable price. The
concatenated string is then assigned to the field cast member Price:

put "$" & price into field "Price"



[
&& (concatenator)

Syntax: expressionl && expression2

This string operator concatenates two expressions, inserting a space character between
the original string expressions. If either expressionl or expression2 evaluates to a
number, it is first converted to a string. The resulting expression is a string.

This is a string operator with a precedence level of 2.

Example 1:

This statement concatenates the strings "abra" and "cadabra", and inserts a space
between the two:

put "abra" && "cadabra"

The result is the string "abra cadabra".

Example 2:

This statement concatenates the strings "Today is" and today's date in the long format,
and inserts a space between the two:

put "Today is" && the long date

If today's date were Tuesday, March 15, 1996, the result would be the string Tuesday,
March 15, 1996.



:) (parentheses)

Syntax: (expression)
This grouping operator performs a grouping operation on an expression. It is used to
control the order of execution of the operators in an expression, and override the
automatic precedence order. It causes the expression contained within the parentheses
to be evaluated first. When parentheses are nested, the contents of inner ones are
evaluated before the contents of outer ones.

This is a grouping operator with a precedence level of 5.

Examples:

These statements use the grouping operator to change the order in which operations
occur. The result appears below each statement:

put (2 + 3) * (4 + 5)

put 2 + 3 * 4 + 5

-- 19



L ]
* (multiplication)

Syntax: expressionl * expression2
This arithmetic operator performs an arithmetic multiplication on two numerical

expressions. If both expressions are integers, the product is an integer. If either or both
expressions are floating point numbers, the product is a floating point number.

This is an arithmetic operator with a precedence level of 4.

Example 1:

This statement multiplies the integers 2 and 3, and then displays the result in the
message window:

put 2 * 3

The result is 6, which is an integer.

Example 2:

This statement multiplies the floating point numbers 2.0 and 3.1414, and then displays
the result in the message window:

put 2.0 * 3.1416

The result is 6.2832, which is a floating point number.



.
+ (addition)
Syntax: expressionl + expression2
This arithmetic operator performs an arithmetic sum on two numerical expressions. If
both expressions are integers, the sum is an integer. If either or both expressions are

floating point numbers, the sum is a floating point number.

This is an arithmetic operator with a precedence level of 4.

Example 1:

This statement adds the integers 2 and 3, and th